# Table of Contents

1 About OnliNet ................................................................. 9
   About OnliNet Centro .................................................. 9
   About OnliNet Lite .................................................... 9
   About OnliNet Vista ................................................... 10
   OnliNet and the Network .............................................. 10
   About the OnliNet Main Screen .................................... 11
      About the Menu Bar ............................................... 11
      About the Toolbar ............................................... 12
      About the OnliNet Status Display ............................. 13
      About the Status Bar ............................................ 13
   Using the OnliNet Guide ............................................. 13
   OnliNet and Your New UPS .......................................... 14

2 Installing OnliNet .......................................................... 15
   Quick Instructions for Windows (32-bit) and Novell NetWare .... 15
   Quick Instructions for UNIX Platforms ............................ 15
   Post-installation Checklist ........................................ 16
   Supported Operating Systems ...................................... 16
   Hardware Requirements ............................................. 16
      Sun Solaris 2.4, 2.5.x, 2.6, and 2.7 ......................... 17
      Digital UNIX 4.0x or Compaq Tru64 UNIX 4.0x .............. 17
      HP-UX 10.10, 10.20, and 11.00 ............................... 17
      IBM AIX 4.1, 4.2, and 4.3 .................................. 17
      SCO UnixWare 2.1, 7, and 7.1 ............................... 17
      Linux Kernel 2.0 and 2.2 (Red Hat Linux 5.x and 6.x) ... 17
      Centro MHS 4.x for IBM AIX 4.1, 4.2, and 4.3 ............. 17
   Hardware Connections for Communications ....................... 17
      Serial Connection ............................................... 17
      Installing the Serial Cable with OnliNet MHS ............... 18
      Network Adapter Connection .................................. 18
   Requirements for E-mail Event Notification ...................... 18
   Installing OnliNet 4.1 for Windows ............................... 18
      Network Adapter ............................................... 19
      Third Party SNMP Network Adapter ........................... 20
   Installing OnliNet 4.1 for Novell NetWare ....................... 21
   Installing OnliNet 4.0 for UNIX ................................... 22
   OnliNet Startup File for UNIX .................................... 23
   Mounting the Install CD (UNIX) ................................... 24
      Sun Solaris 2.4, 2.5.x, and 2.6 ............................ 24
      Digital UNIX 4.0x or Compaq Tru64 UNIX 4.0x ............ 24
      HP-UX 10.10, 10.20, and 11.00 ........................... 24
# Table of Contents

IBM AIX 4.1, 4.2, and 4.3 .................................................. 24
SCO UnixWare 2.1, 7, and 7.1 .............................................. 24
Linux Kernel 2.0 and 2.2 (Red Hat Linux 5.x and 6.x) .............. 25
Centro MHS 4.x for IBM AIX 4.1, 4.2, 4.3 .............................. 25
Installing OniNet 4.x on a Server Without Graphics Capabilities  .................................................. 25
X-terminals ................................................................. 25
Standalone Workstations (on a TCP/IP network with the server)  ......................................................................... 25
PCs Running Windows 95 or NT (on a TCP/IP network with the server) .................................................. 25
Installing OniNet with a Lotus Notes Server ............................. 26
Starting the OniNet 4.x Centro Agent from the Command Line  ......................................................................... 27
   Examples of Starting Manually ......................................... 27
Starting the User Interface from the Command Line .................. 27
   Examples of Starting from the Command Line ..................... 28
SNMP on Windows 9x .......................................................... 28
   Installing the Microsoft SNMP Agent .................................. 28
   Starting and Stopping the SNMP Agent .............................. 28
   Defining the SNMP Source Parameters .............................. 28
   Adding Trap Receivers ................................................... 29
Testing the SNMP Agent Installation ....................................... 29
   Testing on nms_1 from the Windows 95 Command Line .......... 29
   Testing on nms_1 from NetView ....................................... 30
Registering OniNet .............................................................. 30

3 Options for Network Installations ........................................ 31
OniNet and UPS Groups .......................................................... 31
SNMP Capability ............................................................... 31
OniNet and the ConnectUPS SNMP Network Adapter .................. 32
   Configuring the ConnectUPS SNMP Network Adapter ......... 32
   Selecting a Remote Agent in UNIX ................................... 32
Monitoring a Remote Host in Novell NetWare .......................... 33

4 Configuring Communications .............................................. 35
Configuring a Serial Device ................................................... 35
   Disabling the Serial Loopback Test .................................... 36
Configuring a Network Adapter .............................................. 37
   Setting Community Names .............................................. 37
   Setting Timing Values .................................................... 37

5 Shutdown Parameters ....................................................... 39
Configure Shutdown Parameters ........................................... 39
   Accessing the Shutdown Parameters Dialog Boxes ............... 40
   Viewing Shutdown Parameters ....................................... 40
   Deleting a Configured Network Client ............................... 41
Configure Shutdown Parameters - UPS Management Dialog Box .................................................. 41
   Changing the Start Shutdown Parameter ............................ 42
   Changing the Warn Administrator Parameter ....................... 42
   Changing the Warn User Parameter .................................. 43
# Table of Contents

Configure Shutdown Parameters - Software Programs Dialog Box ................................................. 43
About File Saver ................................................................................................................................. 44
  Refreshing the List of Applications Found ...................................................................................... 44
  Creating a Macro for Saving Files and Closing Applications ..................................................... 45
  Preventing Files from Being Overwritten ..................................................................................... 45
  Deleting a Macro ............................................................................................................................ 45
  Testing the Macro .......................................................................................................................... 45
Configure Shutdown Parameters - Non-critical Load Segment Dialog Box ................................... 46
  Determining the Required Shutdown Time for a Non-critical Load Segment ............................... 46
Configure Shutdown Parameters - Network Clients Dialog Box ..................................................... 47
About Discover ................................................................................................................................. 48
UPS Options .................................................................................................................................... 49
  Configuring UPS Options ............................................................................................................ 49
Configuring Events and Actions Notification .................................................................................. 58
Deleting Events and Actions ............................................................................................................ 58
Configuring Pager Recipients ......................................................................................................... 59
  Configuring a Modem and Pager Using TAP Protocol .................................................................. 59
  Configuring a Modem and Pager Without TAP Protocol ............................................................... 60
  Deleting a Pager Recipient ........................................................................................................... 60
Sending a Page to a Configured Recipient ....................................................................................... 60
Configuring E-mail Recipients ......................................................................................................... 62
  Configuring E-mail Recipient Addresses (Windows NT) ............................................................... 62
  Configuring E-mail Recipient Addresses (Windows 9x) ............................................................... 63
  Verifying Your E-mail Configuration ............................................................................................. 63
  Sending E-mail to a Configured Recipient ..................................................................................... 63
Saving Event Information to a Log ................................................................................................. 65

## 6 Getting Information from OnliNet ......................................................................................... 51

Viewing Battery Information .......................................................................................................... 51
  Entering the Last Date of Battery Replacement ............................................................................ 51
  About the Reset Button .................................................................................................................. 51
Viewing Event Log Information ....................................................................................................... 52
  Renaming the Event Log File ......................................................................................................... 52
  Changing the Size of the Event Log File ....................................................................................... 52
  Printing the Event Log File ............................................................................................................ 53
Viewing OnliNet’s Meters ............................................................................................................... 53
  Saving Your OnliNet Meter Setup .................................................................................................. 54
Viewing System Information ........................................................................................................... 54
  Displaying System Information ...................................................................................................... 54
  Listing the UPS’s Attached Devices ............................................................................................... 54
  Displaying the UPS Location .......................................................................................................... 54
  Printing System Information .......................................................................................................... 55
Viewing Diagnostic Results .............................................................................................................. 55
Viewing the UPS Mimic .................................................................................................................... 56
Viewing the Alarm Queue (Powerware Plus UPS Models Only) ....................................................... 56

## 7 Configuring Event Notification .............................................................................................. 57

Configuring Events and Actions Notification ................................................................................ 58
  Deleting Events and Actions .......................................................................................................... 58
Configuring Pager Recipients .......................................................................................................... 59
  Configuring a Modem and Pager Using TAP Protocol .................................................................. 59
  Configuring a Modem and Pager Without TAP Protocol ............................................................... 60
  Deleting a Pager Recipient ........................................................................................................... 60
Sending a Page to a Configured Recipient ....................................................................................... 60
Configuring E-mail Recipients ......................................................................................................... 62
  Configuring E-mail Recipient Addresses (Windows NT) ............................................................... 62
  Configuring E-mail Recipient Addresses (Windows 9x) ............................................................... 63
  Verifying Your E-mail Configuration ............................................................................................. 63
  Sending E-mail to a Configured Recipient ..................................................................................... 63
Saving Event Information to a Log ................................................................................................. 65
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Glossary</td>
<td>103</td>
</tr>
<tr>
<td>Alarms and Alerts</td>
<td>105</td>
</tr>
<tr>
<td>Digital ServerWORKS Manager Plug-in</td>
<td>107</td>
</tr>
<tr>
<td>Cintrix Winframe 1.6</td>
<td>111</td>
</tr>
</tbody>
</table>
CHAPTER 1
ABOUT ONLINET

OnliNet Power Management Software monitors and controls your power system. When its monitoring function detects a power emergency, OnliNet's control functions automatically save your data and gracefully shuts down your system.

In graceful shutdowns, you configure the OnliNet software so there is enough time for data to be saved and programs to be closed before the loss of power forces a shutdown. Such a shutdown is important to avoid any type of data loss or corrupted data due to a power emergency.

The OnliNet family of software products is compatible with major UPSs. All OnliNet features are supported when OnliNet is configured with UPSs with intelligent communication, supporting serial and network communications. Dry-contact UPSs support only the essential information and features in OnliNet including graceful shutdown.

OnliNet includes OnliNet Centro for standard UPSs, OnliNet Lite for dry-contact UPSs, and OnliNet Vista for system administrators. The following sections discuss these programs.

About OnliNet Centro

OnliNet Centro comes with a long list of features for monitoring your UPS power environment and protecting your system and its data. Monitoring features include customizable event notification (paging, e-mail, and a variety of alarms), real-time meter screens, graphical representation of the UPS, event logging, automatic UPS discovery, and battery testing. Control features include scheduled shutdowns, pre-shutdown command execution, and shutdowns and restarts by load segment (when supported by the UPS). The monitoring and controls are performed by a UPS agent on Windows NT and a UPS daemon on UNIX platforms.

OnliNet Centro also supports a variety of features for networks including native operating system SNMP support, remote load segment control (using ConnectUPS™), and UPS group configuration.

About OnliNet Lite

OnliNet Lite offers basic power management of desktop systems that use dry-contact UPSs.

When the sophisticated monitoring and client-server shutdown of OnliNet Centro isn’t needed, OnliNet Lite offers unattended, graceful computer shutdown during an extended power failure. It also includes the same notification methods as OnliNet Centro and keeps a log of power events in the local OnliNet Lite and in a central event log if OnliNet Vista is installed on the network.
About OnliNet Vista

OnliNet Vista is the ultimate remote network-based package for monitoring, configuration, and control of UPSs. OnliNet Vista links and reports information from the OnliNet Centro, OnliNet Lite, and SNMP network adapters for a single approach to enterprise-wide power management.

Through a graphical user interface, system managers can easily select any single UPS or UPS group on the network and customize a range of user-programmable options: shutdown parameters, notification methods, battery tests, resets, and schedule shutdowns for all systems on the network. See “OnliNet Vista” on page 87 for details.

OnliNet and the Network

In the example network shown in Figure 1, OnliNet Vista provides system administrator-level control over all devices. Communication is facilitated by ConnectUPS SNMP network adapters linked to devices that do not ordinarily run a commercial operating system or that are located in a remote part of the network. UPSs support servers and clients running OnliNet Centro with whom they have serial communication. Dry-contact UPSs support servers and clients running OnliNet Lite.
About the OnliNet Main Screen

The OnliNet main screen, shown in Figure 2, consists of a title bar, a menu bar, a toolbar, the color-coded OnliNet status display (green=normal, red=emergency), and the system status bar.

![OnliNet Main Screen (Centro and Lite)](image)

The three images on the main screen represent (from left to right) the agent, the UPS, and utility power. These are the power environment elements that OnliNet monitors. If the UPS agent software stops monitoring the UPS, the agent image turns red. If the UPS stops communicating with the UPS agent or if there is an internal UPS failure, the UPS image turns red. If there is a utility power failure, the utility power image turns red.

**Figure 2. OnliNet Main Screen (Centro and Lite)**

The three images on the main screen represent (from left to right) the agent, the UPS, and utility power. These are the power environment elements that OnliNet monitors. If the UPS agent software stops monitoring the UPS, the agent image turns red. If the UPS stops communicating with the UPS agent or if there is an internal UPS failure, the UPS image turns red. If there is a utility power failure, the utility power image turns red.

**About the Menu Bar**

The OnliNet menus are File, Configure, View, Manage, and Help. The menu titles describe the operations beneath them.

Use the File menu to set up the printer and to exit OnliNet. Use the Configure menu to make adjustments to the system setup. Use the View menu to display detailed system information. Use the Manage menu to run a diagnostics test and to manually start or stop the OnliNet agent. Use the Help menu to access help.
About the Toolbar

The toolbar appears across the top of the OnliNet interface.

If you do not see a complete set of OnliNet icons in the toolbar, it may signal a communication problem. To troubleshoot, on the Configure menu point to Communications, verify your communications setup and try again.

Toolbar icons are grouped by menu. The icons are shown in Table 1.

### Table 1. OnliNet Toolbar Icons

<table>
<thead>
<tr>
<th>![Icon]</th>
<th>Configure Serial Device</th>
<th>![Icon]</th>
<th>View Battery Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Configure Network Adapter</td>
<td>![Icon]</td>
<td>View Event Log Information</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Configure Shutdown Parameters</td>
<td>![Icon]</td>
<td>View Meters</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Configure Events</td>
<td>![Icon]</td>
<td>View System Information</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Configure E-mail Recipients</td>
<td>![Icon]</td>
<td>View Diagnostic Results</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Configure Event Log</td>
<td>![Icon]</td>
<td>View UPS Mimic</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Configure Network Alarm Recipients</td>
<td>![Icon]</td>
<td>Manage Agent Start</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Configure Pager Recipients</td>
<td>![Icon]</td>
<td>Manage Agent Termination</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Configure Password</td>
<td>![Icon]</td>
<td>Manage Diagnostic Test</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Configure Scheduled Diagnostic Test</td>
<td>![Icon]</td>
<td>Problem Report</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Configure Scheduled Shutdown</td>
<td>![Icon]</td>
<td>Owner Registration</td>
</tr>
<tr>
<td>![Icon]</td>
<td></td>
<td>![Icon]</td>
<td>Technical Support</td>
</tr>
</tbody>
</table>
About the OnliNet Status Display
The OnliNet status display signifies whether operations are normal (the color is green) or require attention (the color is red). See Figure 3.
To access help for an event, double-click the event. A help screen opens.

![Figure 3. OnliNet Status Display](image)

About the Status Bar
The optional status bar appears across the bottom of the OnliNet main screen (see Figure 4).
To turn the status bar off, from the View menu clear the Status Bar check box.

![Figure 4. OnliNet Status Bar](image)

Using the OnliNet Guide
Use the OnliNet guide to be sure you know all about OnliNet's features and how to use them:

- If installing OnliNet in a network, be sure you understand your network options. See “Options for Network Installations” on page 31.
- OnliNet will not work properly unless you correctly configure communications, either the serial device or network adapter. See “Configuring Communications” on page 35.
- After installing OnliNet, you can accept the default configuration settings, or you can configure the shutdown parameters. See “Shutdown Parameters” on page 39.
• For descriptions and details on OnliNet's display options, see “Getting Information from OnliNet” on page 51.
• For full details on configuring OnliNet’s event notification system, see “Configuring Event Notification” on page 57.
• Do you know OnliNet’s default password? Do you know how to change it? See “Security” on page 75.
• To set up a diagnostic test, see “Diagnostics” on page 77.
• To schedule shut downs, see “Scheduling Shutdowns” on page 79.
• For management and administration functions, including starting and stopping the agent, owner registration, problem reports, and print setup, see “Management and Administration” on page 83.
• System administrators running OnliNet Vista, see “OnliNet Vista” on page 87.
• UNIX users, see “UNIX Functions” on page 97.
• If you have a problem running OnliNet, see “Troubleshooting” on page 99.

**OnliNet and Your New UPS**

If at any time you install a new UPS on your system, remember that OnliNet has the ability to automatically detect the type of UPS it is communicating with. If you are using a serial cable for communicating with the UPS, be sure to connect the cable before turning on the computer. When the CPU is restarted under the new UPS, OnliNet automatically detects the new UPS and configures itself accordingly.
CHAPTER 2

INSTALLING ONLINET

Although the installation program offers the option of shutting down and rebooting the computer, shutdown of the server is not necessary for completing the installation of OnliNet.

This chapter provides detailed instructions for installing OnliNet. It includes a post-installation checklist, supported operating systems, hardware requirements, hardware connections for communication, requirements for e-mail when using the Event Notification feature, and instructions for installing OnliNet 4.x as follows:

- Installation on Windows, Novell NetWare, and UNIX systems (See “Supported Operating Systems” on page 16)
- Hardware connections for communication
- Installing OnliNet on a server without graphics capabilities
- Installing OnliNet on a system with a Lotus Notes server
- Connecting to SNMP-compliant network management systems

NOTE OnliNet 4.x is not compatible with OnliNet 3.0. If network capabilities are required, then all versions of OnliNet on a network should be upgraded to v.4.x. The installation process for OnliNet 4.0 Centro automatically stops OnliNet 3.0 if it is running, but does not remove the previous version. Remove the old version after the installation of OnliNet 4.x.

When you install from the OnliNet installation CD, the installation program installs OnliNet Centro on systems connected to UPSs by a serial cable or a ConnectUPS SNMP network adapter, and OnliNet Lite on systems supported by a dry-contact UPS. You must log in as a user with administrative privileges before installing OnliNet.

OnliNet Vista is an installation option for 32-bit Windows (Intel and Alpha processor) environments only and for system administrator systems requiring a view of all UPSs in a network or networks. For details, see “OnliNet Vista” on page 87.

Quick Instructions for Windows (32-bit) and Novell NetWare

1. Insert the CD in your computer’s CD-ROM.

   The installation program is configured to auto-start once the CD is inserted.

2. At the main menu, use the installation wizard.

Also, see “Installing OnliNet 4.1 for Windows” on page 18 and “Installing OnliNet 4.1 for Novell NetWare” on page 21.

Quick Instructions for UNIX Platforms

1. Mount the install CD.

2. Run the install script install_onlinet4. For OnliNet for MHS, type install_mhs.

Also, see “Installing OnliNet 4.0 for UNIX” on page 22.
**Post-installation Checklist**

- Configure communication (see “Configuring Communications” on page 35)
- Customize your shutdown parameters (see “Shutdown Parameters” on page 39)
- Configure event notification (see “Configuring Event Notification” on page 57)
- Change your password and know the details of system security (see “Security” on page 75)

**Supported Operating Systems**

OnliNet supports the following operating systems:

- Windows - Windows 95, Windows 98, Windows 2000, Windows NT (Intel and Alpha processors); OnliNet 4.1 will run under Windows NT 3.51 and above and Windows 9x.
- Novell NetWare - OnliNet 4.1 will run under Novell NetWare.
- UNIX - Centro v.4.x for UNIX for the following platforms:
  - Sun Solaris 2.4, 2.5.x, 2.6, and 2.7
  - Digital UNIX 4.0x or Compaq Tru64 UNIX 4.0x
  - HP-UX 10.10, 10.20, and 11.00
  - IBM AIX 4.1, 4.2, and 4.3
  - SCO UnixWare 2.1, 7, and 7.1
  - Linux kernel 2.0 and 2.2 (Red Hat Linux 5.x and 6.x)
- UNIX - Centro MHS 4.x for IBM AIX 4.1, 4.2, and 4.3

**Hardware Requirements**

OnliNet requires 20 MB of free hard disk space, and the ability to mount CD-ROM disks (or the ability to copy the contents of the CD-ROM to a temporary directory, which requires an additional 50 MB). A minimum 32 MB of RAM is recommended.

For serial communication between the computer and UPS, you must install an OnliNet RS-232 communication cable. Network communication can either be between the computer and the network or the UPS and the network by means of a ConnectUPS SNMP network adapter or a third party network adapter installed on the UPS. See “Hardware Connections for Communications” on page 17.

Additional requirements for the Centro UNIX GUI client: a graphics card, a graphics-capable monitor, and X11 (the X-Windows system) Release 6 with Motif 1.2 (or later) installed.

For details for specific UNIX systems for Centro v.4.x, see the following paragraphs.

**Sun Solaris 2.4, 2.5.x, 2.6, and 2.7**

OnliNet 4.x supports the entire family of Sun Sparc and UltraSparc processor-based RISC workstations and servers. Your Sun system must run the Solaris operating environment beginning with version 2.4 (SunOS 5.4). All revisions of Solaris 2.4, 2.5.x, 2.6, and 2.7 are supported. The older SunOS 4.x is not supported.
Digital UNIX 4.0x or Compaq Tru64 UNIX 4.0x
To install and run OnliNet 4.x, you must have an Alpha AXP family RISC workstation or server running Digital UNIX 4.0 or Compaq Tru64 UNIX 4.0.

HP-UX 10.10, 10.20, and 11.00
OnliNet 4.x supports HP workstations and servers running HP-UX 10.10, 10.20, and 11.00.

IBM AIX 4.1, 4.2, and 4.3
OnliNet 4.x supports IBM RS/6000 serial workstations and servers. The supported operating systems are: AIX 4.1, 4.2, and 4.3.

SCO UnixWare 2.1, 7, and 7.1
OnliNet 4.x supports PC-based (Intel 386 or better) UNIX systems running SCO UnixWare 2.1, 7, and 7.1.
OnliNet 4.x will install only if you have the UDK compatibility module for SCO 2.1.x installed on your machine. The install script will check for it and install the package if needed.

Linux Kernel 2.0 and 2.2 (Red Hat Linux 5.x and 6.x)
OnliNet 4.x supports PC-based (Intel 386 or better) UNIX systems running Linux kernel 2.0.
OnliNet 4.x will run on Red Hat Linux 5.0 or later. It may be able to run on other Linux distributions with kernel 2.x, but it is not supported on those distributions.

Centro MHS 4.x for IBM AIX 4.1, 4.2, and 4.3
OnliNet MHS 4.x supports IBM RS/6000 serial workstations and servers with a Powerware® Prestige® Rack Mount UPS. The supported operating systems are: AIX 4.1, 4.2, and 4.3.

Hardware Connections for Communications
Your system must communicate with the UPS. Communication can either be through a serial connection or through a network adapter.

Serial Connection
To connect a UPS to your computer’s serial port, you must have an OnliNet 4.x serial communication cable. If you do not have the cable, contact your UPS sales representative. The OnliNet 4.x cable is especially designed for OnliNet 4.x. If you are upgrading from a previous OnliNet version, the cable used for OnliNet 3.1 will not work correctly.
You may use an RS-232 cable as an extension for your OnliNet 4.x cable. You may also need a gender changer or a 25-pin to 9-pin adapter, depending on your hardware. Do not use a null-modem adapter.

NOTE Although it is not recommended, a standard RS-232 cable can be used. The cable provided with OnliNet provides a special loopback connection so that OnliNet can detect if the cable is disconnected from the computer. To use a standard RS-232 cable, disable the loopback test while reconfiguring the serial communication connection (see page 36).
Installing OnliNet

Installing the Serial Cable with OnliNet MHS

1. Plug one end of a serial cable into the communication port labeled master on the back of the Prestige Rack Mount UPS.

**NOTE** Use only the cables supplied with the UPS.

2. Plug the other end of the serial cable into a dedicated serial communication port on the back of the master RS/6000.

3. Plug a second serial cable into the communication port labeled slave 1 on the back of the Prestige Rack Mount UPS.

4. Plug the other end of the serial cable into a dedicated serial communication port on the back of a slave RS/6000.

5. Repeat Steps 3 and 4 for each additional slave unit.

Network Adapter Connection

In this configuration, the UPS has a ConnectUPS SNMP network adapter or other network adapter installed, enabling the UPS to communicate on the network.

Requirements for E-mail Event Notification

To use the OnliNet event notification e-mail function, Windows systems require a MAPI-compatible e-mail system, Novell NetWare systems require an MHS-compatible mail system, and UNIX systems must configure sendmail.

Installing OnliNet 4.1 for Windows

When you insert the CD-ROM into the appropriate drive, an installation screen opens automatically. If not, run install.exe and install as prompted.

1. Click OnliNet for NetWare or OnliNet for NT/95.
   
   If the installation program detects a system with intelligent serial communication with the UPS, OnliNet Centro is installed. If the program detects a dry-contact UPS, it installs OnliNet Lite.
   
   The installation program looks for previous versions of OnliNet. If a previous version of OnliNet 4.0 is found, it is uninstalled. The program also searches for OnliNet 3.0 and stops it but does not remove it.

2. Choose the installation path. The default is C:\Program Files\OnliNet.
3. Choose a communication type from one of the following options:
   - **Serial Connection** - when communication between the computer and the UPS is by the provided serial cable
   - **ConnectUPS SNMP Network Adapter** - when the UPS has been configured with a ConnectUPS SNMP network adapter connected to the network
   - **Third Party SNMP Network Adapter** - when the UPS has been configured with a third-party network adapter (not a ConnectUPS SNMP network adapter) connected to the network
   - **Client Configuration** - when you install only a UPS group member

4. If installing with serial communication, indicate the computer communication port dedicated to the serial cable. If the serial port is changed in the future, change the configuration. On the Configure menu, point to Communications and click Serial Device.
   
   If installing with the ConnectUPS SNMP network adapter, see the following section, “Network Adapter.” If installing with a third-party SNMP network adapter, see “Third Party SNMP Network Adapter” on page 20.

5. On the Check Setup Information screen, review the installation details.
   
   The UPS monitoring agent is configured to automatically start when the operating system starts. On Windows NT, the UPS monitoring agent is configured as a service. The UPS monitoring agent automatically determines the UPS type when it establishes communication.

**Network Adapter**

If installing OnliNet with the ConnectUPS SNMP network adapter, indicate ConnectUPS Network Adapter as the method of communication with the UPS, as shown in Figure 5, and enter the IP address or host name and password, as shown in Figure 6. Then return to Step 5 on page 19.

![Figure 5. ConnectUPS Network Adapter Communication](image-url)
Third Party SNMP Network Adapter

If installing OnliNet with a third-party SNMP network adapter, indicate Third Party SNMP Network Adapter as the method of communication with the UPS, as shown in Figure 7, and enter the host name, Get Name, and Set Name, as shown in Figure 8. Then return to Step 5 on page 19.

![Figure 6. Hostname and Password Entry for ConnectUPS](image)

![Figure 7. Third Party SNMP Network Adapter Communication](image)
Installing OnliNet 4.1 for Novell NetWare

1. Log into a Novell NetWare server with supervisor privileges. It is recommended that you map a drive to the sys volume of the NetWare server on which you want to install the OnliNet NLM.

2. When you insert the CD-ROM into the drive, the Installation Selection screen opens automatically. If not, run install.exe. The installation wizard screens appear.

   An NLM agent is installed on the NetWare server as part of the installation. If you did not map a drive to the sys volume of the NetWare server on which you want to install the OnliNet NLM, the Choose Directory dialog box opens during installation. Click Network and map the drive.

   The OnliNet Centro NLM and related files are installed in the selected directory on the server. The OnliNet Centro user interface is installed on the workstation.

   **NOTE** If OnliNet Centro for Windows is installed on the workstation, the registry is modified so the Centro user interface can be used to view both local and remote agents.

3. After installation, you must manually start the NLM or boot the server so the NLM starts automatically.

4. When OnliNet Centro for NetWare is started, the Host Selection dialog box opens with a list of all NetWare servers running Centro agents. Select a server and the user interface connects to the UPS monitoring agent on that server.
Installing OnliNet 4.0 for UNIX

1. Log on to UNIX as root.
2. Mount the CD-ROM [see “Mounting the Install CD (UNIX)” on page 24].
3. If installing Centro MHS 4.x for IBM, type:  ./install_mhs
   All others, type:  ./install_onlinet4
   The system verifies:
   • That the user has the correct privileges
   • That OnliNet supports the operating system and platform
4. When prompted, type a path for the software to be installed, or press Enter (Return) to accept the default of /opt.
   Example: To install to /usr4, type in “/usr4” and press Enter.
   The system requests a location for the OnliNet directory. The default is /usr.
   The system performs a space check of the partition to which the files will be copied. If there is insufficient disk space, the install script sends a warning.
5. Designate the type of installation.
   Select one of the following choices:
   1. Install OnliNet daemon and centro client
   2. Install OnliNet daemon only
   3. Install centro client only
   “Install OnliNet daemon and centro client” is the full install option. Selections 2 and 3 are used in performing remote management across a network. Choose option 2, “Install OnliNet daemon only,” if the UNIX station does not have a graphics terminal. Choose option 3, “Install Centro client only,” on a supported platform with a graphics terminal that will be connected to a remote OnliNet agent.
   The install script creates the directory structure for the OnliNet installation and begins copying files. A message opens with the OS version being installed. Once all the files are in place, the script changes all the ownership and group permissions so only the root user may access them (that is, owner=root, group=bin and permissions=-r-x------). Refer to the section concerning security issues related to installing this product.
   NOTE If the install target was a directory other than /opt, the install script still creates a directory /opt/onlinet and places a symbolic link (/opt/onlinet/V4) to the location specified.
6. Select a method of connecting to a UPS.
   Select one of the following choices:
   1. Connect agent to a network adapter
   2. Connect agent to an UPS via a serial port
   3. Run agent in standalone (client) mode
   Choose option 1 for a workstation or server with a Powerware ConnectUPS or other network adapter.
   Choose option 2 for a workstation with a serial port and serial management of the UPS.
Choose option 3 if installing the OnliNet daemon as a client.

| NOTE | With option 3, the workstation does not have a 1:1 relationship with a UPS. For example, a department may install a Powerware 9150 UPS to supply power to several workstations or servers. Only one workstation manages the UPS, but it is desired that all workstations shut down simultaneously in a power failure. To achieve this, install the OnliNet agent (daemon) in client mode (option 3) on all other workstations, and configure the agent (daemon) of the workstation with the serial connection to the UPS to include all the client workstations in its list of remote shutdown clients. |

7. Finish configuring.

For option 1, specify the IP address of the network adapter.

Enter the IP address of the network adapter

If you enter a correct IP address, you are prompted:

Enter the get community name of the network adapter

If you enter a correct get community name, you are prompted:

Enter the set community name of the network adapter

For option 2, specify the serial port device to which the UPS is connected.

What serial port is your UPS connected to? [/dev/term/a]

The example shows the default setting for the Solaris operating environment. Press Enter to select the default, or enter the port name. Include the full path.

For option 3, no further configuration is required for the daemon during the install process.

8. The script creates a startup script for the daemon.

No user action is required. The startup script is initially created in /tmp, then copied to the appropriate location in the file system so that the OnliNet daemon is automatically loaded when the system boots to run level two or higher. The temporary file in /tmp is then deleted.

Screen messages indicate this activity as it occurs. The startup script is named S99onlinet. If there is already a file in the rc2.d directory, the older file is renamed oldS99onlinet.

9. The OnliNet 4.x daemon is automatically started using the S99onlinet script.

To verify that the daemon is running, use the ps command (look for the name OnliNetd). The install script sends a message that OnliNet 4.0 is installed successfully.

10. (Optional) Install the Centro client.

The final message shows the command line to use to invoke the client. For example:

/opt/onlinet/V4/gui/run_centro <options>

The install script should now close and return the terminal to its shell prompt.

**OnliNet Startup File for UNIX**

During installation of OnliNet Centro for UNIX, install_onlinet4 modifies or creates certain system files to start the OnliNet agent automatically on startup. The startup file is named s99onlinet and typically it is placed in the /etc/rc2.d directory.
Mounting the Install CD (UNIX)

For all systems, log in as root before mounting the OnliNet installation CD. See the following instructions by program.

**Sun Solaris 2.4, 2.5.x, and 2.6**

On Solaris 2.4, 2.5.x, and 2.6 the operating system should automatically mount the CD-ROM upon insertion, creating a directory named after the CD-ROM’s volume label under the default mount point (/cdrom). It should look something like: /cdrom/onlinet4.

**Digital UNIX 4.0x or Compaq Tru64 UNIX 4.0x**

To properly mount the CD-ROM on a Compaq (Digital) UNIX system, use the following command:

```
mount -t cdfs -r /dev/rz4c /cdrom
```

**NOTE** You may need to create a directory as a mount point (mkdir /cdrom) or use /mnt as the mounting point. And the device name of your cdrom may be different from the above example (/dev/rz4c), you must replace it with the correct device name.

**HP-UX 10.10, 10.20, and 11.00**

On HP-UX 10.10, 10.20, and 11.00 you can use the system administration tool SAM to mount the CD-ROM on the file system. Or you can use the following command to mount the CD-ROM:

```
mount /dev/dsk/cxtxdx /cdrom
```

**NOTE** The “/dev/dsk/cxtxdx” is the name of your CD-ROM drive. You can use the following command to find the name of your CD-ROM drive:

```
ioscan -funCdisk
```

**IBM AIX 4.1, 4.2, and 4.3**

On IBM AIX 4.1, 4.2, and 4.3 you can use the system administration tool SMIT to mount the CD-ROM on the file system. Or you can use the following command to mount the CD-ROM:

```
mount -v cdrfs -r /dev/cd0 /mnt
```

**NOTE** The “/dev/cd0” should be changed to the name of your CD-ROM drive.

**SCO UnixWare 2.1, 7, and 7.1**

On SCO 2.1, 7, or 7.1, you can use the following command:

```
mount -F cdfs -o ro /dev/cdrom/c0b0t1l0 /mnt
```

**NOTE** The device name of your cdrom may be different from the above example (/dev/cdrom/c0b0t1l0), you must replace it with the correct device name.
**Linux Kernel 2.0 and 2.2 (Red Hat Linux 5.x and 6.x)**

On Linux kernel 2.0, you can use the following command:

```
mount -o ro /dev/cdrom /mnt
```

**NOTE** If the device name of your CD-ROM differs from the above example (/dev/cdrom), replace it with the correct device name.

**Centro MHS 4.x for IBM AIX 4.1, 4.2, 4.3**

Use the system administration tool SMIT or type:

```
mount -v cdrfs -r /dev/cd0 /mnt
```

**NOTE** If the device name of your CD-ROM differs from the above example (/dev/cd0), replace it with the correct device name.

---

**Installing OnliNet 4.x on a Server Without Graphics Capabilities**

You do not need graphics capabilities to install OnliNet on your UNIX server. X-Windows is required only if you run the Centro client to configure the daemon (agent) and monitor the UPS. There are three options: X-terminals, standalone workstations, and Windows 95 or NT.

**X-terminals**

If your X-terminal boots from the server, install the OnliNet 4.x daemon and Centro GUI on the server. You can run Centro and export its display to the X-terminal and manage the server that way.

**Standalone Workstations (on a TCP/IP network with the server)**

If you have other workstations with graphics capabilities, your options are:

1. You may install the OnliNet 4.x agent and Centro GUI on the server and use the remote display capabilities of X-Windows to display Centro on a remote workstation. This method works best if you have workstations and servers from vendors that OnliNet 4.x has not yet been ported to.
2. If all your equipment is from the same vendor, you can install the OnliNet 4.x agent on the server, then install the Centro client on a workstation with X-Windows capabilities. When you run Centro from the command line, use the -h option to specify the IP address of the server where the agent is running.

**PCs Running Windows 95 or NT (on a TCP/IP network with the server)**

If you don’t have any UNIX systems with X-Windows capabilities, you should install only the OnliNet 4.x agent on your server. Any PC running Windows 95 or NT with OnliNet Centro 4.x for Windows installed can configure and monitor the agent installed on the server. The converse is also true—OnliNet 4.x agents running on Windows can be managed from Centro running on UNIX. Any OnliNet Centro 4.x client can talk to any OnliNet 4.x agent, regardless of the operating system.
Installing OnliNet with a Lotus Notes Server

During the installation, OnliNet searches for an installed version of Lotus Notes. If found, the Install Lotus Notes Shutdown Option dialog box opens as shown in Figure 9. Clicking Yes starts the process of installing a program called Noteskiller which shuts down the Lotus Notes server before shutting down the operating system.

![Figure 9. Install Lotus Notes Shutdown Option Dialog Box](image)

The steps for installing Noteskiller are as follows:

1. In the Install Lotus Notes Shutdown Option dialog box, click yes.
2. In the Shutdown Application Installation dialog box, specify a destination directory for the Noteskiller program. The default is the directory where Notes is installed.
3. Click Next. You are prompted to enter a server name and password. Note the reminder that says you must reconfigure Noteskiller anytime you change the server name or password for your Lotus Notes server.
4. In the Configure Shutdown Parameters - Software Programs dialog box, check “Run a pre-shutdown command before the operating system is shut down” and enter `C:\lotus\notes\noteskiller.exe /s` (see Figure 18 on page 43).
Starting the OnliNet 4.x Centro Agent from the Command Line

The OnliNet 4.0 Centro agent can be started from the command line. For Windows 95, the filename is agent95.exe. For Windows NT, the filename is agentnt.exe. For Unix platforms the daemon filename is onlinetd. The following command line switches are available:

<table>
<thead>
<tr>
<th>Command Line Switch</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-a currentdir</td>
<td>Sets the current working directory (Windows 95 only)</td>
</tr>
<tr>
<td>-b</td>
<td>Starts the agent in debug mode (console output) Required when starting the Windows NT agent from the command line</td>
</tr>
<tr>
<td>-d serial_device</td>
<td>The agent starts in serial mode connected to this com port (e.g., com1)</td>
</tr>
<tr>
<td>-c adapter_name</td>
<td>The agent starts in network mode connected to this ConnectUPS or network adapter (e.g., 192.58.67.25)</td>
</tr>
<tr>
<td>-g community_name</td>
<td>Sets the “get” community name for the network adapter (e.g., public)</td>
</tr>
<tr>
<td>-s community_name</td>
<td>Sets the “set” community name for the network adapter (e.g., private)</td>
</tr>
<tr>
<td>-x onlinet_mode</td>
<td>Starts the agent in a specific mode</td>
</tr>
<tr>
<td>0</td>
<td>Serial Normal, no clients</td>
</tr>
<tr>
<td>1*</td>
<td>Serial Master, controlling clients (MHS)</td>
</tr>
<tr>
<td>2*</td>
<td>Serial Slave (MHS)</td>
</tr>
<tr>
<td>3</td>
<td>Serial, with networked clients (NETWORK MASTER)</td>
</tr>
<tr>
<td>4</td>
<td>Contact Closures</td>
</tr>
<tr>
<td>5</td>
<td>Idle state</td>
</tr>
<tr>
<td>6</td>
<td>Networked client (NETWORK SLAVE)</td>
</tr>
<tr>
<td>7</td>
<td>Demo Mode</td>
</tr>
</tbody>
</table>

* Modes 1 and 2 are not implemented at this time.

Examples of Starting Manually

Start the agent on Windows NT connected to COM2: agentnt -b -d com2
Start the agent connected to a ConnectUPS: agentnt -b -c 192.58.67.25 -g public -s private
Start the agent on Windows 95 connected to COM2: agent95 -d com2

Starting the User Interface from the Command Line

The OnliNet 4.0 Centro user interface can be started from the command line by typing “centro” alone or followed by the following command line switches:

<table>
<thead>
<tr>
<th>Command Line Switch</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-h host name</td>
<td>Connects the user interface to the OnliNet agent on the specified host name (use a domain name or IP address)</td>
</tr>
<tr>
<td>-n</td>
<td>Do not display Splash Screen</td>
</tr>
<tr>
<td>-g community name</td>
<td>Sets the “get” community name for the network adapter</td>
</tr>
<tr>
<td>-s community name</td>
<td>Sets the “set” community name for the network adapter</td>
</tr>
<tr>
<td>-cm communication mode</td>
<td>Sets the Centro UI communication mode</td>
</tr>
<tr>
<td>0</td>
<td>IP mode</td>
</tr>
<tr>
<td>1</td>
<td>IPX mode</td>
</tr>
<tr>
<td>2</td>
<td>SNMP mode</td>
</tr>
</tbody>
</table>
Examples of Starting from the Command Line
Connect to a remote OnliNet agent by typing:  centro -cm0 -h 192.58.67.21
Connect to a ConnectUPS by typing:  centro -cm2 -h 192.58.67.25 -g public -s private

SNMP on Windows 9x
To use simple network management protocol (SNMP) on Windows 9x systems, you must install and configure the Microsoft SNMP agent according to the following procedures.

Installing the Microsoft SNMP Agent
1. On your Windows 9x desktop, right-click Network Neighborhood, and click Properties.
2. In the Network dialog box, click Add.
3. In the Select Network Component Type dialog box, double-click Service.
4. In the Select Network Service dialog box, click Have Disk.
5. In the Install From Disk dialog box, type the path or use Browse to find the directory on your Windows 9x installation CD. If using the developer’s CD, the path is OSR2\ADMIN\NETTOOLS\SNMP. For other CDs, the path may vary.
6. In the Select Network Service dialog box, click Microsoft SNMP Agent in the model list, then click OK twice.
7. Restart the computer.

Starting and Stopping the SNMP Agent
To start the SNMP Agent without restarting the machine, at the DOS command prompt type SNMP. To stop, type SNMP -close.

Defining the SNMP Source Parameters

NOTE Be aware that mistakes made to the registry can result in a non-working system.

1. Run the Registry Editor (regedit).
2. In the Registry Editor, select the following key:
   Hkey_Local_Machine\System\CurrentControlSet\Services\SNMP\Parameters\RFC1156Agent
3. Or, in the Registry Editor dialog box, choose Find from the Edit Menu (Ctrl+F).
   In the Find dialog box, type sysLocation.
4. In the Registry Editor, double-click sysLocation.
5. In the Edit String dialog box, type your machine’s location in the Value data box. This text is used to display the location of the SNMP agents computer.
6. In the Registry Editor, double-click sysContact.
7. In the Edit String dialog box, type the name of your contact person in the Value data box.
Adding Trap Receivers

**NOTE** Be aware that mistakes made to the registry can result in a non-working system.

You need to create a string value name for each console that will receive traps from the SNMP and to specify a value data for each value name.

1. In the Registry Editor, select the following key: `Hkey_Local_Machine\System\CurrentControlSet\Services\SNMP\Parameters\ValidCommunities`
2. Click Edit->New->String Value.
3. Type the value name (1, 2, 3, and so on).
4. Specify the value data for each string value name by double-clicking the string value name and typing the value data. The value data must be a valid community string (“public” is typical).
5. In the Registry Editor, select the following key: `Hkey_Local_Machine\System\CurrentControlSet\Services\SNMP\Parameters\TrapConfiguration`
6. Click Edit->New->Key.
7. Enter the name of the folder.
   Name the folder “public” or assign a specific name for the new community.
8. Create a new string value name in the just created folder for each network management console to which the SNMP should send traps with this community name, and specify the value data for each string value name.
   To create a string value number, choose Edit->New->String Value, and type the value name (1, 2, 3, and so on.).
9. Specify the value data for each string value name by double-clicking the string value name and typing the value data. The value data must be the IP address of the network management console designated as the trap receiver.

Testing the SNMP Agent Installation

The following test procedures apply to an IBM AIX computer, whose host name is nms_1 on the IP network 192.58.67.14, using an IBM system utility to verify system information on a remote Windows 95 system.

**Testing on nms_1 from the Windows 95 Command Line**

1. Type `Telnet < nms_1 > [or <192.58.67.14 >]` and Login as root.
2. Type: `snmpinfo -m d -v -c public -h<IP address of the Windows 95 computer being verified> system.`
Testing on nms_1 from NetView

1. As root user, start NetView, by typing nv6000.

2. Look at the submap that appears on the submap window. Double-click the IP Internet symbol on the Root submap.

3. At the IP Internet submap, double-click the highlighted network symbol IP address, <192.58.67.14>.

At the Network submap, double-click the segment symbol. Your computer should show up as an SNMP network object. The computer’s name or IP address should appear on the submap.

Registering OnliNet

To register OnliNet 4.x, on the Help menu click Owner Registration.
CHAPTER 3
OPTIONS FOR NETWORK INSTALLATIONS

This chapter discusses options and tools for network systems available within OnliNet Centro, including:
• UPS groups
• SNMP capability
• ConnectUPS SNMP network adapter
• Selecting a remote agent in UNIX
• Monitoring a remote host in Novell NetWare

OnliNet and UPS Groups

The UPS group is a network configuration option in which one system, called the UPS Group Controller (or Centro server), has serial communication with the UPS while the UPS provides protected power for the UPS Group Controller and several UPS Group Members (Centro clients). UPS groups are an ideal solution when one large UPS requires fewer resources than multiple smaller UPSs. As shown in Figure 10, communication is via the network.

SNMP Capability

OnliNet can send the standard UPS traps to any network management system. OnliNet can forward the standard SNMP UPS alarms to a network management system.

By default, OnliNet uses the TCP/IP protocol on all platforms. If TCP/IP is not installed on a NetWare server, OnliNet automatically uses the IPX protocol. It is highly recommended that TCP/IP be installed on a NetWare system because without it OnliNet is not visible to UNIX-based systems.
OnliNet and the ConnectUPS SNMP Network Adapter

OnliNet Centro supports the ConnectUPS SNMP network adapter and third-party SNMP network adapters. Network adapters allow for remote monitoring of a UPS and for multiple instances of OnliNet Centro to communicate with the same UPS.

The ConnectUPS SNMP network adapter can be either Ethernet (unshielded twisted-pair/thinwire) or Token Ring (shielded/unshielded twisted-pair).

**NOTE** The Timed Shutdown feature is not supported with firmware version 1.03 of the ConnectUPS.

**NOTE** If you are communicating with a ConnectUPS SNMP network adapter with OnliNet running on the Novell NetWare platform, the password displayed in the ConnectUPS configuration screen is “private.” This must be changed to correspond to the user configured password in the ConnectUPS. If no password was configured in the ConnectUPS, then change “private” to the ConnectUPS default password. The ConnectUPS default password is provided in the ConnectUPS manual.

**NOTE** If you are using OnliNet Vista and a ConnectUPS to monitor a UPS, under certain conditions the UPS/ConnectUPS combination may appear on the main Vista screen twice. This occurs when an OnliNet agent is running on a computer on the network and is communicating with the ConnectUPS.

Configuring the ConnectUPS SNMP Network Adapter

It is important that the IP address, netmask, and gateway are correctly configured for the network. Refer to the ConnectUPS Adapter User’s Guide for detailed instructions.

For configuring the adapter in OnliNet, see “Configuring a Network Adapter” on page 37. For configuring network alarm recipients, see “Configuring Network Recipients” on page 69.

Selecting a Remote Agent in UNIX

Because OnliNet Vista is available only for Windows, UNIX systems in particular benefit from the ability to connect to OnliNet Centro at remote systems from the command line, using the -cm and -h parameters.

The -cm parameter sets the communication mode where 0=IP mode and 1=IPX mode. The -h parameter is the domain name or IP address of the remote agent. Examples follow.

Typing `centro -cm0 -h celeron` starts Centro on remote system celeron in IP mode.

Typing `centro -cm0 -h 192.58.67.21` starts Centro at remote IP address 192.58.67.21 in IP mode.

Typing `centro -cm1 -h deer_valley` starts Centro on remote system deer_valley in IPX mode.
Monitoring a Remote Host in Novell NetWare

1. On the Configure menu, point to Options and click Show startup access mode dialog (see Figure 11).

2. In the Centro Communications Access Mode dialog box (see Figure 12), do one of the following:
   - Choose Default when you want the user interface to communicate with the OnliNet agent running on your local machine
   - Choose Remote Servers when you want the user interface to discover and communicate with remote OnliNet agents running on NetWare.

   The Remote Servers mode allows communication with an OnliNet agent monitoring a UPS serially connected to a server or a network-connected UPS.

3. If you choose Remote Servers, select a host to view from the Host Selection list (see Figure 13).

![Figure 11. On the Configure Menu, Point to Options and Click Show Startup Access Mode Dialog](image-url)
Figure 12. Centro Communications Access Mode Dialog Box

**Show dialog at startup.** Select to cause the Centro Communications Access Mode dialog box to open each time OnliNet Centro starts.

If the Show dialog at startup box is cleared, OnliNet Centro attempts to re-establish communication in the last active access mode.

To change access modes, configure the change and restart OnliNet Centro.

To change remote servers, configure the change and restart OnliNet Centro.

Figure 13. Host Selection Dialog Box

When you select a remote file server, the OnliNet Centro main screen for the server appears.
CHAPTER 4
CONFIGURING COMMUNICATIONS

For OnliNet software to work, there must be communication between the UPS and the computer running OnliNet. In a simple system, a UPS and a computer are linked by a serial communication cable. In a UPS group, one UPS directly supports several computers and sends information via a serial cable to one of the computers which then relays it via the network to the other supported computers in the system.

In a networked system, the UPS communicates with OnliNet over the network via a ConnectUPS SNMP network adapter. Several OnliNet UPS agents can communicate with one ConnectUPS. OnliNet Vista can monitor any UPS with a network connection.

To communicate with a UPS, OnliNet requires a single, dedicated serial port or a ConnectUPS SNMP network adapter that can be used to provide communication through an Ethernet or token-ring network. Communication through parallel ports is not supported.

OnliNet uses special cables designed to detect a cable disconnection. OnliNet comes with two cables, one for the 25-pin UPS connection and one for the 9-pin UPS connection. Because there are many variables on computer interfaces, some UPS models may require an adapter, such as a 9-pin to 25-pin adapter or a “gender-bender.”

This chapter provides instructions for the following:

- configuring a serial device
- configuring a network adapter

Configuring a Serial Device

Use the Configure Serial Device dialog box to configure the serial communication port on your computer that will be used for communicating with the UPS. If you change the serial port to which the serial cable is attached on your computer, you must reconfigure the serial device in OnliNet.

1. On the Toolbar click , or on the Configure menu point to Communications and then click Serial Device.
2. Enter the host name or IP address of the serial device in the Device Name field (see Figure 14).
The Configure Serial Device dialog box options are discussed in the following paragraphs.

**Local Serial Device (default for most installations)**. Click if your UPS has only one serial port. The UPS port is configured for communication with OnliNet.

**Server Serial Device**. Click if your UPS has more than one serial port and the port is the primary, controlling port (server/master). The UPS is configured to send and receive responses from OnliNet.

**Client Serial Device**. Click if your UPS has more than one serial port and the port is controlled by another device (client/slave). The OnliNet agent can only receive messages from this port.

**Device Name**. Enter the host name or IP address of the serial device in the Device Name field.

![Configure Serial Device Dialog Box](image)

**Figure 14. Configure Serial Device Dialog Box**

**NOTE** For OnliNet to establish communication with the UPS and protect your equipment, you must enter the correct device name.

**Disabling the Serial Loopback Test**

When the checkbox is activated, OnliNet Centro can tell if an OnliNet cable is attached to the specified serial port. This option, for Windows systems only, allows you to disable the loopback test so you can use a serial cable other than the OnliNet cable.
Configuring a Network Adapter

Use the Configure Network Adapter dialog box to configure the OnliNet agent to communicate through a network adapter with the UPS. This function is only available to network systems running OnliNet Centro.

1. On the Toolbar click [image], or on the Configure menu point to Communications and then click Network Adapter.
2. In the Configure Network Adapter dialog box, enter the host name or IP address of the adapter (see Figure 15).

![Figure 15. Configure Network Adapter Dialog Box](image)

After you enter the host name or IP address, the Configure Network Adapter dialog box refreshes. If your network adapter recognizes Net BCM, the dialog box displays information for the network adapter and UPS, the password (represented by asterisks), and fields for updating the timing values. If your network adapter does not recognize Net BCM, the dialog box displays fields for entering the Get Community Name and Set Community Name in place of the information for the network adapter and UPS.

**Setting Community Names**

1. In the Password field, enter the network adapter’s password.
2. Click Verify Password(s).
3. In the Get Community Name field, enter the community name that the SNMP manager uses when performing a get operation.
4. In the Set Community Name field, enter the community name that the SNMP manager uses when performing set or get operations.

**Setting Timing Values**

1. In the Password field, enter the network adapter’s password.
2. Click Verify Password(s).
3. In the Polling Interval field, enter the interval for agent updates to system status.
   For networks with heavy traffic, you may want to increase this value to reduce the frequency at which OnliNet communicates over the network to the UPS.
4. In the Time-out Values field, enter the time the agent will wait before reporting lost communication with the UPS.
5. Click Update to make the timing value changes effective.
One of the following messages appears after you configure network communication:

- **Normal Operation** - This message is displayed under normal conditions.
- **No UPS attached** - Attach a working UPS to the system.
- **Adapter not found** - Check for possible causes and correct.
CHAPTER 5
SHUTDOWN PARAMETERS

When you install OnliNet, shutdown parameters are applied by default. You can reconfigure these parameters at any time, and you can take advantage of OnliNet’s optional shutdown parameters. After experiencing a power failure, you may wish to review your shutdown parameters to be sure they have met your needs.

If you are installing a UPS group, configure your UPS group members, passwords, and shutdown timing using the Configure Shutdown Parameters - Network Clients dialog box. UPS group members should always have a shorter shutdown time than the UPS group controller. This is made easy if your UPS supports load segments.

**NOTE** If OnliNet detects that the UPS has approximately two or five minutes (specified on the Low Battery Warning option) or less of battery time remaining during power outage, OnliNet automatically performs a systematic shutdown, regardless of the shutdown parameters.

OnliNet gives you significant control over your system’s usage of the UPS battery. Parameters you can configure include:

- Length of UPS battery support before system shutdown
- Whether to turn off the UPS after the rest of the system is shut down
- Delay before the system administrator is warned
- Delay before the user is warned
- Whether to run File Saver before shutdown
- Whether to execute a command before shutdown
- Individual shutdown delays for each load segment
- Network clients for UPS groups

**Configure Shutdown Parameters**

Configure Shutdown Parameters is a series of dialog boxes used to specify the shutdown parameters for your system. These dialog boxes and their functions are as follows:

**Configure Shutdown Parameters** - Shows the currently configured shutdown parameters for your system

**Configure Shutdown Parameters - UPS Management** - Displays the inputs for the currently configured shutdown parameters in editable fields

**Configure Shutdown Parameters - Software Programs** - Displays the inputs for operating system shutdown and provides the option to run the File Saver program and a pre-shutdown command.

**Configure Shutdown Parameters - Non-Critical Load Segment** - Contains options for configuring load segments (if supported by the UPS).

**Configure Shutdown Parameters - Network Clients** - For configuring the shutdown of network clients for UPS groups.
NOTE The minutes on battery before starting the shutdown process and the operating system shutdown time must be equal to or less than the total battery time available.

Accessing the Shutdown Parameters Dialog Boxes

1. On the Toolbar click , or from the Configure menu choose Shutdown Parameters.
   The Shutdown Parameters dialog box opens showing the shutdown times you have configured.
2. In the Configure Shutdown Parameters dialog box, click Configure.
   The Configure Shutdown Parameters - UPS Management dialog box opens.
3. On the Configure Shutdown Parameters - UPS Management dialog box, click Next.
   The Configure Shutdown Parameters - Software Programs dialog box opens.
4. On the Configure Shutdown Parameters - Software Programs dialog box, click Next.
   The Configure Shutdown Parameters - Non-Critical Load Segment dialog box opens.
5. On the Configure Shutdown Parameters - Non-Critical Load Segment dialog box, click Next.
   The Configure Shutdown Parameters - Network Clients dialog box opens.
   When configuration is complete, choose OK to close the Configure Shutdown Parameters - Network Clients dialog box and return to the Configure Shutdown Parameters dialog box to review your changes.

NOTE Complete path names must be used in specifying the command and also in all script and batch files.

Viewing Shutdown Parameters

The Configure Shutdown Parameters dialog box shows the shutdown parameters and provides access to the configuration dialog boxes (see Figure 16).

![Figure 16. Configure Shutdown Parameters Dialog Box]
The following sections describe the display and dialog box controls.

**Machine Name** - A list of currently configured systems and their shutdown parameters, such as the start shutdown time, the operating system shutdown time, and the times to warn different users.

**Time to the nearest minute.** The graph to the right of the machine names displays the configured time to the nearest minute.

**Color Legend.** The legend shows color-coded definitions for the Time to the nearest minute graph.

**Configure.** Click to continue to the Configure Shutdown Parameters - UPS Management dialog box.

### Deleting a Configured Network Client

1. From the Machine Name list, select a configured network client.
2. Click Delete.

#### Configure Shutdown Parameters - UPS Management Dialog Box

The Configure Shutdown Parameters - UPS Management dialog box shows the inputs for currently configured shutdown parameters for your system.

**NOTE** The total battery time available cannot be greater than the combined value of the on-battery time and the operating system shutdown time. Operating system shutdown time is entered on the Configure Shutdown Parameters - Software Programs dialog box.

![Configure Shutdown Parameters - UPS Management Dialog Box](image.png)

*Figure 17. Configure Shutdown Parameters - UPS Management Dialog Box*
The following sections describe the dialog box controls.

**What is the total battery time available?** The default is 7 minutes. This is the time that most new UPSs are capable of supporting a full load. Users may adjust the number, for example, when adding external battery packs. When you enter an answer to the next question (How long do you want to wait after the UPS goes on battery before starting the shutdown process?) the system reviews this number. If you lack sufficient battery time, you receive a warning. The value you enter here does not apply to OnliNet’s meters. Total battery time available depends on the type of UPS, the number of batteries included with the UPS, and the total load requirements. The battery time is approximate. If you do not know the total battery time available, refer to your UPS user’s guide.

**How long do you want to wait after the UPS goes on battery before starting the shutdown process?** When a power outage occurs, the UPS goes on battery to protect your equipment. Enter the amount of time the UPS should remain on battery before OnliNet starts the shutdown process.

**Turn off UPS after shutdown is complete?** Select this option to save UPS battery life after shutting down your equipment. Otherwise, the UPS will continue to run on battery until it is completely discharged or until power is returned.

**How long do you want to wait after the UPS goes on battery before warning the administrator?** Enter the delay (in minutes) after the UPS goes on battery before the system alerts the administrator.

**How long do you want to wait after the UPS goes on battery before warning the users?** Enter the delay (in minutes) after the UPS goes on battery before the system alerts the users.

**Next.** Click to continue to the Configure Shutdown Parameters - Software Programs dialog box.

### Changing the Start Shutdown Parameter

1. In the Configure Shutdown Parameters dialog box, click Configure.
2. In the Configure Shutdown Parameters - UPS Management dialog box, change the answer to “How long do you want to wait after the UPS goes on battery before starting the shutdown process?”
3. Click OK to return to the Configure Shutdown Parameters dialog box and review your change.

### Changing the Warn Administrator Parameter

1. In the Configure Shutdown Parameters dialog box, click Configure.
2. In the Configure Shutdown Parameters - UPS Management dialog box, change the answer to “How long do you want to wait after the UPS goes on battery before warning the administrator?”
3. Click OK to return to the Configure Shutdown Parameters dialog box and review your change.
Changing the Warn User Parameter

1. In the Configure Shutdown Parameters dialog box, click Configure.

2. In the Configure Shutdown Parameters - UPS Management dialog box, change the answer to “How long do you want to wait after the UPS goes on battery before warning the users?”

3. Click OK to return to the Configure Shutdown Parameters dialog box and review your change.

Configure Shutdown Parameters - Software Programs Dialog Box

Configure Shutdown Parameters - Software Programs shows the inputs for operating system shutdown and provides the option to run and configure File Saver or a pre-shutdown command.

The following sections describe the dialog box controls.

**How long does it take for the operating system to shut down under normal conditions?**

OnliNet performs a clean and efficient shutdown of your operating system during the battery-powered grace period provided by the UPS. Enter the amount of time (in minutes) that your operating system takes to shut down properly. If you select the File Saver or Pre-shutdown Command options, you must include the times for these processes to complete; otherwise, the UPS may turn off your computer before the shutdown is complete.

**Run the File Saver program before the operating system is shut down.** The File Saver program allows you to save files and close applications before shutting down the operating system. To configure this option, select the File Saver check box, click Setup File Saver, and complete the information on the File Saver dialog box. See “About File Saver” on page 44.
Run a pre-shutdown command before the operating system is shut down and Run the pre-shutdown command during a low battery shutdown. OnliNet can initiate a pre-shutdown command before the operating system shuts down and during a low battery shutdown. If either or both options are checked, the Pre-shutdown Command field appears at the bottom of the dialog box. Enter the command that OnliNet should initiate. Enter the complete path name (for example, c:\windows\clock.exe).

**NOTE** Complete path names must be used in specifying the command and also in all script and batch files.

### About File Saver

File Saver is a program within the Configure Shutdown Parameters - Software Programs option. Use the File Saver dialog box to create macros that close applications and save the associated files when a power failure is detected.

**NOTE** The macro can only save one file associated with an application. If more than one file is open within a specific application, only the primary file is saved.

The Applications Found list contains all currently open applications. The Macros Built list contains existing macros for the applications.

**Refreshing the List of Applications Found**

If an application does not appear in the Applications Found list, click Search. Any newly opened applications are listed.
Creating a Macro for Saving Files and Closing Applications

1. From the Applications Found list, select an application.
2. Click Build to start the macro recording process.
3. Perform the steps in the application to be saved in your macro.
4. On the application File menu, click Save As and name and save the macro.
5. Exit the application.
6. Click Stop to end the macro recording process.
7. (Optional) Click Test to verify that the macro functions as expected. Before testing the macros, make sure that the application is running with a file open.

Preventing Files from Being Overwritten

1. In the Applications Found list, select an application.
2. Check Use Sequential File Names.
3. In the File Name Prefix box, type a file name. The default prefix is TEMP but you can rename it with up to four characters, such as WORD for Word documents.
4. In the File Name Extension box, type a 3-character extension for the file.
5. Click Build.
6. On the application File menu, click Save As.
7. In the Save As dialog box, type insert11.now in the File Name and save.
8. Close the application.
9. In File Saver, click Stop.
   This allows you to save files in sequential order and prevent files from being overwritten by accident.

Deleting a Macro

1. In the Macros Built list box, select the macro.
2. Click Delete.

Testing the Macro

1. Open a file in the application.
2. In the OnliNet File Saver dialog box, click Test.

NOTE: While testing the macro, estimate the time needed to complete and add this time to the operating system shutdown time in the Configure Shutdown Parameters - Software Programs dialog box.
Configure Shutdown Parameters - Non-critical Load Segment Dialog Box

If your UPS supports load segment control, use Configure Shutdown Parameters - Non-Critical Load Segment as follows:

- Select the load segment with the non-critical hardware.
- Enter a delay (in minutes) after the UPS goes on battery before turning off the non-critical receptacles.
- Enter a delay (in minutes) after utility is restored until the non-critical segment is turned on.

The following sections describe the dialog box controls.

**Select which segment contains the non-critical hardware.** If your UPS contains two or more load segments, you can designate one to support critical hardware and the other for non-critical hardware.

**How long do you want to wait after the UPS goes on battery before turning off the non-critical segment?** Typically, the non-critical load segment will be kept running for little or no time after the UPS goes on battery.

**How long do you want to wait after utility power is restored before turning on the non-critical segment?** Since the equipment on this load segment is non-critical, you may wish to consider a delay in starting after utility power is restored.

**Next.** Click to continue to the Configure Shutdown Parameters - Network Clients dialog box.

**Determining the Required Shutdown Time for a Non-critical Load Segment**

1. In the Configure Shutdown Parameters - Non-Critical Load Segment dialog box select a non-critical load segment.
2. In response to the question How long do you want to wait after the UPS goes on battery before turning off the non-critical segment, enter 0 to 255 minutes.
3. In response to the question How long do you want to wait after utility power is restored before turning on the non-critical segment, enter 0 to 5 minutes.
Configure Shutdown Parameters - Network Clients Dialog Box

In the Configure Shutdown Parameters - Non-Critical Load Segment dialog box, click Next.

**NOTE** Before you can configure shutdown parameters for a UPS group member (network client), the UPS group member must be running OnlNet.

Configure the UPS group members (network clients) from the UPS group controller (host).

A UPS group is a system consisting of one UPS supporting two or more computers where:

- One computer (known as the UPS group controller or host) communicates with the UPS either serially or through a network adapter.
- The other computers (known as the UPS group members or network clients) are powered by the same UPS.

The UPS group members are configured to be in an idle mode awaiting commands from the UPS group controller.

![Configure Shutdown Parameters - Network Clients Dialog Box](image)

The following sections describe the dialog box controls.

**Which network client do you want to configure the shutdown parameters?** Select a network client. If you do not see the network client you want to configure, click Discover. See “About Discover” on page 48.

**What is the password of the selected network client?** You must enter the correct password for the selected network client.

**How long do you want to wait after the master UPS goes on battery before starting the shutdown process of the client?** When a power outage occurs, the master UPS goes on battery to protect your equipment. Enter the amount of battery time (in minutes) that the UPS should use before shutting down the network client.
How long do you want to wait after the master UPS goes on battery before warning the users and administrator of the network client? Enter the time (in minutes) to wait after the master UPS goes on battery before warning the network client's users and administrator of the pending shutdown.

**Add.** Click to add the network client information to the list of configured shutdowns.

**Delete.** Click to remove the selected network client.

**OK.** Click OK to save all options specified on each configuration dialog box, close the Configure Shutdown Parameters - Network Clients dialog box, and return to the main Configure Shutdown Parameters dialog box where you can view your changes.

**Cancel.** Click Cancel to return to the Configure Shutdown Parameters dialog box without saving your changes.

### About Discover

The Discover dialog box opens when you click Discover on the Configure Shutdown Parameters - Network Clients dialog box. Use the Discover dialog box to specify other subnet masks or host IP addresses that were not discovered when OnliNet was started.

![Discover Dialog Box](image)

**Figure 22. Discover Dialog Box**

The following sections describe the dialog box controls.

**Subnet.** Specify a network broadcast subnet or host IP address you want OnliNet to monitor.

**Subnets to Search.** This list box contains a list of all previously added subnets. These subnets are searched automatically when OnliNet is started.

**Add.** Click to add the subnet entered in the Subnet field to the Subnets to Search list box. OnliNet Vista will then search this subnet for devices each time the application is started.

**Delete.** Click to remove the selected subnet from the list.
**UPS Options**

If your UPS supports it, you can specify whether the UPS low battery warning alarm appears at two minutes or five minutes, and you can turn the UPS audible alarm on or off. You can also display the type of UPS attached to your system.

**NOTE** If OnliNet detects that the UPS has approximately two or five minutes (specified on the Low Battery Warning option) or less of battery time remaining during power outage, OnliNet automatically performs a systematic shutdown, regardless of the shutdown parameters.

---

**Configuring UPS Options**

1. On the Toolbar click or from the Configure menu choose UPS Options.

**NOTE** If your UPS does not support this feature, UPS Options is not available on the menu.

2. Select the Low Battery Warning option. The default is 2 minutes.
3. Select the Audible Alarm Status option. The default is On.
CHAPTER 6
GETTING INFORMATION FROM ONLINET

OnliNet provides information about your system in a variety of viewable forms as follows:
- Battery Information - including total time spent on battery
- Event Log Information - a record of events and alarms
- Meters - gauges and list boxes
- System Information - system basics
- Diagnostic Results - a record of all diagnostic tests for the system
- UPS Mimic - a picture of your system
- Alarm Queue - a list of alarms available only if the OnliNet agent is monitoring a Powerware Plus UPS

Viewing Battery Information

On the Toolbar click , or from the View menu choose Battery Information. The View Battery Information dialog box contains information about the UPS batteries, and allows you to enter a date when the battery was last replaced.

- **Time of Last Reset** - When the battery information was last set to zero by clicking Reset.
- **Number of Outages** - Power outages that have occurred since the last reset.
- **Total Time on Battery** - Time (in seconds) that the system has been powered by the battery.
- **Average Seconds on Battery** - Average amount of time the system spends on battery power.
- **Number of Low Battery Warnings** - Number of times the UPS has indicated the battery is low.
- **Time of Last Low Battery Warning** - Date and time of the most current low battery warning.

Entering the Last Date of Battery Replacement

In the Date Battery Replaced field, type the date you replaced the UPS battery, or when you installed a new UPS.

About the Reset Button

Use the Reset button with caution. Reset is irreversible. Clicking Reset changes all fields, including the Date Battery Replaced field, to zero. Click Reset only when you replace the UPS battery.
Viewing Event Log Information

On the Toolbar click , or on the View menu click Event Log Information. The View Event Log Information dialog box appears displaying events processed and alarms issued by the OnliNet agent.

![Figure 23. Event Log Information]

The Event Log holds a specified number of events defined in the Configure Event Log dialog box (see Figure 32 on page 66). Each Event Log entry includes a sequential event number, the date and time, and a description of the event.

Renaming the Event Log File

1. Click Configure.
2. In the Configure Event Log dialog box, enter the name of the file where you want the event log information to be stored. The default is logfile.dat. Click Browse to select a file from other directories.

Changing the Size of the Event Log File

1. Click Configure.
2. In the Configure Event Log dialog box, enter the maximum number of lines to be stored in the Event Log file in the Maximum Entries field. The default is 100 lines.
Printing the Event Log File

You can print the event log file to an ASCII file or to a printer.

1. Click Print.
2. To print to a printer, the Print Setup option under the File menu must have a valid printer destination capable of printing ASCII files.

By default, all system events are entered in the Event Log. To reconfigure the Event Log, see “Configuring Event Notification” on page 57.

Viewing OnliNet’s Meters

You can display power measurement information on OnliNet’s graphical gauges. OnliNet’s gauges depend on the UPS for their information. Any displayed information should be taken as a guideline and not an exact representation.

1. On the Toolbar click or from the View menu choose Meters.
   The View Meters dialog box opens (loading may take a few moments) with a selection of meters (see Figure 24).
2. On the View Meters dialog box, double-click a meter name. The appropriate meter opens.

![View Meters Dialog Box](image)

Figure 24. View Meters Dialog Box

All gauges indicate a normal operating zone (shown in green) as defined by the UPS specification. Available meters include, but are not limited to the following:

- **Percent Load - Linear** - The real output power as a percentage. Double-click to view meter parameters.
- **Output Power - Apparent** - The apparent output power from the UPS in volt-amperes. The apparent output power is the output voltage multiplied by the output current.
- **Percent Load - Non-Linear** - The apparent output power as a percentage.
Battery Voltage - The voltage of the UPS battery.
Battery Time Remaining - The approximate time remaining on the UPS battery.

**NOTE** You can configure OnliNet to send On-Battery warnings as often as once a minute. If the UPS supports it, you can configure the Low Battery Warning Time. By default, this time is set to two minutes in the UPS. Some UPS products allow you to adjust this to five minutes, thus providing more time to shut down the operating system when the batteries are nearly depleted.

Input Frequency - The frequency (Hz) of the power input to the UPS.
Output Frequency - The frequency (Hz) of the output from the UPS.
Output Power - Real - The UPS output power capacity being used by the load in watts (W). This value equals the output voltage (V) times the current (A) times the power factor.
Input Voltage - The utility power value.
Output Voltage - The voltage (V) exiting the UPS.
Output Current - The output current from the UPS in amperes (A).
Input Voltage - The voltage entering the UPS from the power source.
Battery Capacity - The capacity of the UPS battery.
Temperature - The operating temperature of the UPS in Celsius.

**Saving Your OnliNet Meter Setup**
1. Click Save View.
2. Click OK.

Each time you re-open OnliNet's meters, this selection of meters appears.

**Viewing System Information**

You can display information about the UPS, OnliNet software, and computer system. The system information varies according to the attached UPS model. You can also add information about the devices powered by the UPS and the location of the UPS. Information displayed is as follows:

**UPS Description** - Describes the attached UPS with such information as UPS make and model, serial number, version, and topology.

**UPS Ratings** - Rating information such as the input and output voltage, and the frequencies of the attached UPS.

**Software** - Type and version of the OnliNet software and the operating system.

**Displaying System Information**

On the Toolbar click , or from the View menu choose System Information. The UPS description, UPS rating, and software information appears.

**Listing the UPS’s Attached Devices**

In the Powered Devices field, enter the device names.

**Displaying the UPS Location**

In the Location field, enter the location.
Printing System Information
You can print the event log file to an ASCII file or to a printer.

1. Click Print.
2. To print to a printer, the Print Setup option under the File menu must have a valid printer destination capable of printing ASCII files.

Viewing Diagnostic Results
This option shows the date, time, and status of each diagnostic test. Diagnostic tests are initiated under the Manage menu.

To display diagnostic results:

On the Toolbar click or on the View menu click Diagnostic Results.
The View Diagnostic Results dialog box shows the date, time, and status of any previous diagnostic tests (see Figure 25).

Figure 25. View Diagnostic Results Dialog Box
**Viewing the UPS Mimic**

On the Toolbar click ☰, or from the View menu choose UPS Mimic. The View UPS Mimic is a graphical representation of the power between the UPS and the computer system (see Figure 26).

![Figure 26. View UPS Mimic Dialog Box (Line-Interactive UPS)](image)

When operating in normal mode, the UPS Mimic shows the UPS filtering incoming AC power, eliminating noise and voltage spikes, and providing consistent power output to your equipment. The background of the View UPS Mimic dialog box is green.

In an emergency, when the UPS shifts to bypass mode or battery mode, the background color of the View UPS Mimic dialog box changes to yellow or red.

**Viewing the Alarm Queue (Powerware Plus UPS Models Only)**

The Alarm Queue contains a sequentially numbered list of alarms. The list shows the date, time, and a description of each alarm.

To view the alarm queue, from the View menu choose Alarm Queue (if available).

This dialog box is available only when an OnliNet agent is monitoring a Powerware Plus UPS. It shows the internal alarm queue of the UPS in tabular format.
## Chapter 7
### Configuring Event Notification

You can configure OnliNet so that when an event takes place the system performs an action. If there is a power failure, a low-battery situation, or other system problem, you can program OnliNet to make a number of responses. OnliNet can send a page, e-mail, administrative warning, network message, remote warning, or user warning; enter the event in an event log; or execute a command.

The following is a list of all the available events for which an action can be performed.

<table>
<thead>
<tr>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Bad Battery Detected</td>
</tr>
<tr>
<td>2. Bad Battery Alarm Cleared</td>
</tr>
<tr>
<td>3. UPS On Battery</td>
</tr>
<tr>
<td>4. Utility Power Restored</td>
</tr>
<tr>
<td>5. Low Battery</td>
</tr>
<tr>
<td>6. Low Battery Alarm Cleared</td>
</tr>
<tr>
<td>7. UPS Component Failed</td>
</tr>
<tr>
<td>8. UPS Component Failed Alarm Cleared</td>
</tr>
<tr>
<td>9. Input Out of Tolerance</td>
</tr>
<tr>
<td>10. Input Parameters Returned to Normal</td>
</tr>
<tr>
<td>11. Overload</td>
</tr>
<tr>
<td>12. Overload Alarm Cleared</td>
</tr>
<tr>
<td>13. Bypass</td>
</tr>
<tr>
<td>14. UPS Returned From Bypass</td>
</tr>
<tr>
<td>15. Communication with UPS Lost</td>
</tr>
<tr>
<td>16. UPS Re-established Communication</td>
</tr>
<tr>
<td>17. Utility Over Voltage - Buck</td>
</tr>
<tr>
<td>18. Clear Utility Over Voltage - Buck</td>
</tr>
<tr>
<td>19. Utility Under Voltage - Boost</td>
</tr>
<tr>
<td>20. Clear Utility Under Voltage - Boost</td>
</tr>
<tr>
<td>21. Software Error</td>
</tr>
<tr>
<td>22. Software Error Cleared</td>
</tr>
<tr>
<td>23. Program Started</td>
</tr>
<tr>
<td>24. Program Terminated</td>
</tr>
<tr>
<td>25. Remote Configuration Change</td>
</tr>
<tr>
<td>26. Scheduled Shutdown</td>
</tr>
<tr>
<td>27. Shutdown Due to Power Failure</td>
</tr>
</tbody>
</table>
Configuring Event Notification

All events are pre-configured to be logged to the OnliNet event log. Some events are UPS-specific and may or may not appear in the list depending upon the type of UPS that OnliNet is monitoring.

Before configuring paging, e-mail, or network messages, you must first configure recipients.

### Configuring Events and Actions Notification

1. On the Toolbar click [ ], or on the Configure menu point to Notification, and then click Events.
2. In the Select an Event area of the Configure Events dialog box, select an event such as Low Battery or Utility Power Restored. To select multiple events, press Ctrl and click.
3. In the Select an Action area of the Configure Events dialog box, click the icon or icons for the action or actions desired, as follows:

<table>
<thead>
<tr>
<th>Action</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td>![Page Icon]</td>
</tr>
<tr>
<td>E-mail</td>
<td>![E-mail Icon]</td>
</tr>
<tr>
<td>Log Event</td>
<td>![Log Event Icon]</td>
</tr>
<tr>
<td>Administrative Warning</td>
<td>![Administrative Warning Icon]</td>
</tr>
<tr>
<td>Execute Command</td>
<td>![Execute Command Icon]</td>
</tr>
<tr>
<td>Network Manager Messages</td>
<td>![Network Manager Messages Icon]</td>
</tr>
<tr>
<td>Remote Message</td>
<td>![Remote Message Icon]</td>
</tr>
<tr>
<td>User Warning</td>
<td>![User Warning Icon]</td>
</tr>
</tbody>
</table>

4. Enter the requested information in the dialog box when it opens.

   The event and the action configured appear in the Configured Events list box.

### Deleting Events and Actions

CAUTION

You are not prompted to confirm a deletion. If you accidentally delete an event and action, you must reconfigure.

1. Select the event in the Configured Events list box. To select several events, press Ctrl and click.
2. Click Delete.

   The event and the action disappear from the Configured Events list box.

Detailed procedures for configuring each action are provided in the sections that follow.
Configuring Pager Recipients

You can configure your system so OnliNet pages one or two users in response to an event. You must configure your pager recipients before the system can send a page in response to an event.

![Configure Pager Recipients Dialog Box](image)

**Figure 27. Configure Pager Recipients Dialog Box**

### Configuring a Modem and Pager Using TAP Protocol

1. On the Toolbar click 📱, or on the Configure menu point to Notification and click Pager Recipients.
   
   The Configure Pager Recipients dialog box opens.

2. In the Recipient Information area of the Configure Pager Recipients dialog box, enter the following:
   - In the Name field, the name of the person being paged.
   - In the Access Number field, the telephone number for the paging company modem that receives alphanumeric numbers. [Note that this is different from the pager telephone number and may include dashes. A comma usually causes a 2-second pause.] If a password is required, follow the phone number with the ^ symbol (shift 6) and the password, for example: 692-2000^password.
Configuring Event Notification

- In the Pager PIN Number field, the pager’s ID number.
- In the Maximum Characters Per Message Block field, the number of characters per message block supported by the paging company.

3. In the Modem Setup area, select the modem being used and the following information:
   - Port name for the modem.
   - Baud rate. The default is 9600.
   - The modem initialization string.
   - The modem dial string.

4. Click Add.

Details for the configured recipient appear in the Configured Recipients list.

**Configuring a Modem and Pager Without TAP Protocol**

The procedure is the same as for TAP protocol with the following exceptions:

1. In the Recipient Information area, clear the Paging Company Supports TAP Protocol check box.
2. An Access Number is not required.
3. In the Delay Seconds field, enter the time (in seconds) to wait between dialing the pager company and starting to transmit a pager message.
4. In the Termination String field, enter the paging company’s assigned code. The default is #.

**Deleting a Pager Recipient**

1. In the Configured Recipients list box, select a pager recipient.
2. Click Delete.

**Sending a Page to a Configured Recipient**

Configure Pager Recipients before configuring notification by pager.

1. On the Toolbar click , then on the Configure Events dialog box, select an event and click .

**NOTE** The following events are not supported: Program Terminated, Shutdown Due To Power Failure, Shutdown Due To Low Battery, No UPS Configured, and UPS discovered.

2. In the Configure Pager dialog box, select a recipient to page (see Figure 28).
Enter the following:

- Message text to be sent to the recipient.
- The delay (in minutes and seconds) before the message is to be sent. The default is 2 minutes.
- The number of times to retry the page. The default is 2. Up to 10 retries can be entered.
- The amount of time (in seconds) before a page is retried. The default is 20 seconds.

If the recipient list is empty or to add a new recipient, click Add Pager Recipients and enter the required information on the Configure Pager Recipients dialog box.

To verify that the recipient can be paged successfully, click Test.
Configuring E-mail Recipients

You can configure one or two e-mail addresses to be notified when a specific event occurs. You can notify one or both recipients. For each e-mail recipient, you must specify a name and a complete e-mail address.

The Configure E-mail Recipients dialog box must be completed before you can send an e-mail in response to an event.

NOTE For OnliNet to send e-mail from a Windows system, your e-mail package must be an application that supports the 32-bit MAPI protocol. UNIX systems require that sendmail be configured. It is strongly recommended that you verify your configuration.

Configuring Recipient Addresses (Windows NT)

1. On the Toolbar click or on the Configure menu point to Notification and click E-Mail Recipients.

   The Configure E-mail Recipients dialog box opens (see Figure 29).

   ![Configure E-mail Recipients Dialog Box (Windows NT)](image)

   **Figure 29. Configure E-mail Recipients Dialog Box (Windows NT)**

2. In the Configure E-mail Recipients dialog box, enter the name of each e-mail recipient in the Name 1 and Name 2 fields (for example, mjones).

3. Enter your Windows NT user name.

4. Enter the domain name.

5. Enter your Windows NT password (the password is displayed as asterisks).
Configuring E-mail Recipient Addresses (Windows 9x)

1. On the Toolbar click \( \text{Configure E-mail} \) or on the Configure menu point to Notification and click E-Mail Recipients.

2. In the Configure E-mail Recipients dialog box, enter the address of the recipient(s) in the Address 1 and Address 2 fields (for example, John@mycompany.com).

3. Enter the name of each e-mail recipient in the Name 1 and Name 2 fields (for example, John Admin).

Verifying Your E-mail Configuration

1. Set up your system to send e-mail.

2. Configure OnliNet to send e-mail when there is a loss of communication with the UPS.

3. Create a loss of communication by unplugging your computer from your UPS to verify that the system will send e-mail to a recipient as intended.

   If the expected message does not arrive, re-open the Configure E-mail Recipients dialog box and experiment with other formats in the Name1 and Name2 fields. Responses to an e-mail signal vary with servers and e-mail systems, and finding the setup that works for your system may be a matter of trial and error. Some options to try are as follows:

   - Type the recipient's name per the system address book (for example, Mary Smith).
   - Type the recipient's e-mail address (for example, Mary Smith@yourcompany.com).
   - Create a local address book in your e-mail system.

Sending E-mail to a Configured Recipient

1. On the Toolbar click \( \text{Configure E-mail} \), then on the Configure Events dialog box, select an event and click \( \text{Configure E-mail} \).

   NOTE The following events are not supported: Program Terminated, Shutdown Due to Power Failure, Shutdown Due to Low Battery, No UPS Configured, and UPS discovered.

2. In the Configure E-mail dialog box, select a recipient to e-mail (see Figure 30).
3. Enter the message text to be sent to the recipient.

4. Enter the delay (in minutes and seconds) before the message is to be sent. The default is 2 minutes.

If the recipient list is empty or you want to add a new recipient, click Add E-mail Recipients and fill out the required information on the Configure E-mail Recipients dialog box.
**Saving Event Information to a Log**

By default, all events are entered in your log file. The log file is a sequential record of OnliNet events and UPS alarms, including the time, date, and description. You also have the option of logging OnliNet events to the operative system’s application log.

The related procedures and dialog boxes are as follows:
- Specifying whether an event is logged if it occurs - Configure Events dialog box and Log Event dialog box.
- Naming a log file or specifying its size - Configure Event Log dialog box.
- Viewing an event log - View Event Log dialog box.

**NOTE** The Event Log is not an ASCII file. It can be displayed only when you use OnliNet.

**Specifying Whether an Event is Logged**

1. On the Toolbar click , then on the Configure Events dialog box, select an event and click .

The Log Event dialog box opens (see Figure 31).

![Log Event Dialog Box](image)

**Figure 31. Log Event Dialog Box**

2. In the Log Event dialog box, select or clear the following:
   - Log event to the OnliNet Event Log file
   - Log event to the Application Log file

The OnliNet Event Log file is a sequential record of OnliNet events and UPS alarms, including the time, date, and description. The Application Log file is available only through Windows NT and is an option of the Event Viewer.
Naming or Configuring a Log File

1. Do one of the following:
   - From the Log Event dialog box, click Configure.
   - From the Event Log dialog box, click Configure.

   The Configure Event Log dialog box opens (see Figure 32).

2. Enter the complete name of the file where you want the event log information to be entered or click Browse to select a file. The default is logfile.dat.

3. In the Maximum Entries field, enter the maximum number of entries. The default is 100 events. The field range is 10 to 100.

Viewing the Event Log

On the Toolbar click , or on the View menu click Event Log Information.

Viewing the Application Log (Windows NT)

1. Click Start and point to Programs/Administrative Tools/Event Viewer.
2. On the Event Viewer Log menu, click Application.
Configuring Administrative Warnings

When a particular event occurs, you can configure OnliNet to send a visual or an audible warning message with a specified delay and frequency to all network systems running OnliNet. If the message is visual, you can accept the system text, or you can change the wording.

Accessing the Configure Administrative Warning Dialog Box

On the Toolbar click, then on the Configure Events dialog box, select an event and click .

NOTE The following events are not supported: No UPS Configured and UPS discovered.

![Configure Administrative Warning Dialog Box](image)

Figure 33. Configure Administrative Warning Dialog Box
Defining the Warning Message

1. Check either Visual Message or Audible Message.
   The event you selected in the Configure Events dialog box appears in the Message Text field. If you select Audible Message, enter the audio file in the Audio File Name field. The PC or workstation to which the message is sent must be capable of generating the audible alarm.

2. Enter the delay (in minutes) for sending the first message. The default is 0 minutes.

3. Enter the frequency (in minutes and seconds) between subsequent messages. The default is 1 minute.

Setting a Command to be Executed

You can specify a command to execute in response to an event. You can also specify the time to wait before running the command.

Accessing the Configure Execute Command Dialog Box

On the Toolbar click [button], then on the Configure Events dialog box, select an event and click [button].

**NOTE** The following events are not supported: Shutdown Due to Power Failure, Shutdown Due to Low Battery, Remote Shutdown, No UPS Configured, and UPS discovered.

![](image)

*Figure 34. Configure Execute Command Dialog Box*
Specifying a Command
1. In the Complete path and file name field, enter the path and file name of the command. For Novell NetWare, precede the path and file name with the command load. If necessary, click Browse to select a command from other directories. The command name cannot exceed 255 characters and must include the full path name.
2. Enter the Time to wait before executing the command (in minutes and seconds). The default is 0. The field range is 0 to 20 minutes and 59 seconds.

Sending Network Alarm Messages
You can configure your OnliNet system so SNMP traps are sent to network managers running management programs such as HP OpenView and Digital (Compaq) ServerWORKS Manager. Before you can configure the traps to be sent, you must configure network recipients.

Configuring Network Recipients
1. On the Toolbar click or on the Configure menu point to Notification and click Network Alarm Recipients.
   The Configure Network Alarm Recipients dialog box opens (see Figure 35). The Network Manager Type is SNMP.

![Configure Network Alarm Recipients Dialog Box](image)

Figure 35. Configure Network Alarm Recipients Dialog Box
2. Windows and UNIX users: In the Parameters area of the Configure Network Alarm Recipients dialog box, enter a host name and community name (public or private) for the network manager in the appropriate fields.

Novell NetWare users: Open sys\etc\traptarg.cfg and follow the instructions for entering the names of trap recipients.

The system allows you to specify up to eight hosts for each network manager type. The maximum size of each field is 255 characters.

3. Click Add. The host and community names appear in the list box.

Deleting a Network Recipient

1. In the Configure Network Alarm Recipients dialog box, select the host name to be deleted. To delete several host names, press Ctrl and select all the host names to be deleted.

2. Click Delete.

Sending SNMP Traps to Configured Recipients

1. On the Toolbar click ![icon], or on the Configure menu point to Notification and click Events.

2. On the Configure Events dialog box, select an event and click ![icon].

The Configure Network Manager Message dialog box opens (see Figure 36).

![Figure 36. Configure Network Manager Message Dialog Box]
NOTE The following events are not supported: Software Error, Software Error Cleared, Program Started, Program Terminated, Remote Configuration Change, Scheduled Shutdown, Shutdown Due To Power Failure, Shutdown Due To Low Battery, Remote Shutdown, No UPS Configured, UPS discovered.

3. On the Configure Network Manager Message dialog box, select a Network Manager Host Name.
4. Enter the time (in minutes and seconds) to wait before sending the first message. The default is 2 minutes.
5. Enter the time (in minutes and seconds) to wait between subsequent messages. The default is 1 minute.

If the network manager list is empty or to add or delete a network manager, click Add Network Alarm Recipients and fill out the required information on the Configure Network Alarm Recipients dialog box.

Configuring Remote Messages

You can configure OnliNet so that in response to an event, the system sends messages to one of the remote computers running an OnliNet agent.

1. On the Toolbar click the notification icon, or on the Configure menu point to Notification and click Events.
2. In the Configure Events dialog box, select an event and click .

NOTE The following events are not supported: Remote Configuration Change, Scheduled Shutdown, Shutdown Due To Power Failure, Shutdown Due To Low Battery, No UPS Configured, and UPS discovered.

The Configure Remote Message dialog box opens as shown in Figure 37.
3. In the Send Message To field select or enter a valid remote host system to notify in response to an event.

   Optional: To add to the list, click Discover. The Discover dialog box opens (see Figure 38).

4. Enter the message text. It is recommended that you include the name of the system generating the message.

5. Enter the delay (in minutes) before the message is sent. The default is 0. The range is up to 60 minutes.

6. Enter the time interval between subsequent messages (in minutes and seconds). The default is 0. The range is up to 60 minutes.
Using Discover to Build a List

1. Specify other subnet masks or host IP addresses not discovered when OnliNet was started.
2. Click Add.

Configuring Warnings to All Users

NOTE This action is not available in the Windows 95 and Windows 98 operating system environments.

You can send a warning message to all known users in response to an event.

1. On the Toolbar click , or from the Configure menu point to Notification and click Events.

2. In the Configure Events dialog box, select an event and click The User Warning Configuration dialog box opens (see Figure 39).

NOTE The following events are not supported: No UPS Configured and UPS discovered.
3. In the User Warning Configuration dialog box Message field, enter the message to be sent to all known users.

4. Enter the delay (in minutes) before the message is sent. The default is 0. The range is up to 20 minutes.

5. Enter the time interval between subsequent messages (in minutes and seconds). The default is 1 minute. The field range is 0 to 20 minutes and 59 seconds.

NOTE For user warning messages to appear on the screens of clients connected to a Novell NetWare server, the clients must be running winpopup.exe. To have winpopup.exe run every time the system starts, add it to the startup folder.
CHAPTER 8

SECURITY

OnLiNet has a default password system. The password must be entered before shutting down the system and for all features found in the Manage menu. The password is case-sensitive; the default is 1Power. It is recommended that you change the password immediately after installing OnLiNet.

Setting Your Password

1. On the Toolbar click , or from the Configure menu choose Password.
2. In the Configure Password dialog box, enter the existing password in the Old Password field.
3. Enter your new password in the New Password field.
4. Verify the new password by entering the new password in the Confirm New Password field.

Security and UNIX Systems

OnLiNet can shut down any workstation or computer running an OnLiNet agent or daemon. This ability is password-protected.

Only the system administrator, logged in as the root user, should be able to use OnLiNet. The installation process sets all file ownerships and permissions to restrict access. Use the following guidelines to ensure that these settings are correct:

- All files are owned by root (uid 0)
- All files belong to group “bin” and nothing else
- All file permissions are set to -r-x------

The OnLiNet 4 agent should run as a daemon process with an effective uid of root. Other non-root users should be prevented from being able to start or kill the agent daemon.

The X-Windows system has its own type of access control. The OnLiNet agent (daemon) includes a small Motif program that duplicates any console messages to a system-modal dialog box that pops up on the screen if X-Windows is running. However, to receive these messages, disable access control for the display, using the following command:

    $xhost + <machine name>

For security reasons, become familiar with UNIX security. Do not use the xhost command to allow access. In some instances, the benefits of receiving graphical console messages may not be worth the potential security hazards.
CHAPTER 9
DIAGNOSTICS

If supported, the UPS will perform a diagnostic test on the UPS at specified intervals. With OnliNet, you can:
• Run a one-time diagnostic test
• Run a schedule of diagnostic tests
• View the results of diagnostic tests

CAUTION
To conserve battery life, it is recommended that diagnostic tests be performed no more than once a month.
For OnliNet Vista: If the selected host is in a user-created group, the diagnostic test is run on all hosts in that group. For example, if you select and run a diagnostic test on any host from the group "MyHosts," which is user-created, the diagnostic test is run on all hosts in "MyHosts."

Running a One-time Diagnostic Test

1. On the Toolbar click or from the Manage menu choose Diagnostic Test.
2. In the Manage Diagnostic Test dialog box, click OK (see Figure 40).
   The OnliNet status display reads Diagnostic Test in Progress until the test is complete. Then the OnliNet status display reads Normal Operation.

![Manage Diagnostic Test Dialog Box](image)

Figure 40. Manage Diagnostic Test Dialog Box
Running Scheduled Diagnostic Tests

Configure OnliNet to automatically run diagnostic tests at the interval you specify. A diagnostic test puts your system on UPS battery power for a few seconds to be sure it is in good working order. To protect your UPS battery, the minimum frequency for scheduled tests is every 35 days.

Setting the Parameters for the Diagnostic Test

1. On the Toolbar click , or from the Configure menu choose Scheduled Diagnostic Test. The Configure Scheduled Diagnostic Test dialog box opens (see Figure 41).

![Configure Scheduled Diagnostic Test Dialog Box](image)

Figure 41. Configure Scheduled Diagnostic Test Dialog Box

2. In the Perform Test list, select the day of the week the test should be performed.
3. In the Repeat every ___ days field, enter the number of days until the next test.
4. In the Time field, enter the hour when the test will begin.
5. In the Maximum entries in results file box, enter a number.
6. In the File Name field, specify a results file.
7. Click Schedule to schedule the test or Unschedule to remove the next scheduled test.

Viewing the Results of Previous Tests

Click Results.

The View Diagnostic Results dialog box shows the time and status of current and previous tests.

Viewing the Results of Diagnostic Tests

On the Toolbar click , or from the View menu choose Diagnostic Results.
CHAPTER 10
SCHEDULING SHUTDOWNS

OnliNet enables you to schedule regular shutdowns and restarts of your equipment, including load segments and UPS group members. You can configure the UPS to shut down once, daily, weekly, monthly or at intervals of up to 999 days, and to restart at any time up to 10,041 days, 7 hours, and 39 minutes (999 days, 999 hours, and 999 minutes) later.

Scheduling is accomplished through the Configure Scheduled Shutdown dialog box shown in Figure 42.

You can also specify exceptions to the shutdown. For example, you can turn off the system daily at 6 PM, restart the system at 9 AM the next day, except for a certain day, when you may want the shutdown delayed until 9 PM. The current configuration and the next 10 scheduled shutdowns, if configured, are displayed.

You can delay the scheduled shutdown for up to 60 minutes. OnliNet continues with the shutdown and restarts commands at the previously scheduled times when the delay expires.

The scheduled shutdown is ignored if the computer is already turned off when a scheduled shutdown should occur.

OnliNet Centro, when functioning in the server mode as a UPS group controller, notifies all UPS group members (clients) of pending shutdowns. You can configure the length of time before the shutdown occurs and the client systems are notified.

If schedule conflicts occur for timed shutdowns, OnliNet performs the shutdown according to the following priorities:

- Once takes precedence over Weekly
- Weekly takes precedence over Monthly
- Monthly takes precedence over Daily
Scheduling a Shutdown

1. On the Toolbar click , or from the Configure menu choose Scheduled Shutdown.

2. In the Shutdown area of the Configure Scheduled Shutdown dialog box, select the desired shutdown frequency.
   Choose Once to shut down and restart the system one time only. If you choose Every Day, select or clear Skip Weekends. If you choose Every Week, select the day of the week on which the shutdown should occur. If you choose Every Month, select the date of each month on which the shutdown should occur.

3. In the Starting area, set the start date and time for the shutdown.

4. In the Restart area, set the date and time for the system to come back on line.

5. (If supported) In the Segment groups area, select the load segment to be shut down.

6. Click Add to add the shutdown parameters to the list, Cancel to close the dialog box without entering changes, or Delete to remove a selected shutdown from the schedule.

7. When the Enter Password dialog box opens, enter your password. The default is 1Power.

Figure 42. Configure Scheduled Shutdown Dialog Box
Configuring Shutdown Parameters for Client Computers Attached to the Same UPS

1. In the Configure Scheduled Shutdown dialog box, click Client.
2. In the Configure Network Client dialog box, enter the appropriate information.

Delaying the Scheduled Shutdown

| NOTE | This feature is available only when a scheduled shutdown is configured. |

1. In the Configure Scheduled Shutdown dialog box, select the shutdown to be delayed.
2. Click Delay Shutdown.
3. In the Delay Scheduled Shutdown dialog box, enter the delay time in minutes.

Scheduling Shutdowns for UPS Groups

You can schedule shutdowns for UPS groups, systems in which multiple computers are attached to a single UPS with one computer (the UPS group controller) having serial communication with the UPS while the others (UPS group members) communicate with the UPS group controller over a network. Because only one computer can communicate directly with the UPS through the serial communication port, you must configure a UPS Group controller’s UPS group members which are also known as network clients.

Configuring Network Clients

1. In the Configure Scheduled Shutdown dialog box, click Client.

   The Configure Network Client dialog box opens (see Figure 43).
Figure 43. Configure Network Client Dialog Box

2. Select a network client from the list of available network addresses (host names or IP addresses). This list is limited to clients with OnliNet Centro installed and running. To add subnets, click Discover.

3. Enter the password for the client.

4. Enter Minutes prior to UPS turn off to notify administrator.

5. Enter Minutes prior to master UPS turn off to shut down client.

6. Click Add.

Changing the Parameters for a Client

1. From the list of configured network clients, select the network address of the client to be deleted.

2. Click Delete.

3. Re-enter the client with the new parameters.

NOTE You can also configure scheduled shutdown parameters for a client by clicking Configure on the Configure Shutdown Parameters dialog box, then clicking Next until the Configure Shutdown Parameters - Network Clients dialog box opens (see Figure 21 on page 47).
Functions included in this chapter are as follows:

- Starting and stopping the agent
- Registering your software
- Filing a problem report
- Printing

Starting the Agent

The OnliNet agent must be started before OnliNet can monitor your system. No password is required to start the OnliNet agent. This command has no effect if the OnliNet agent is already running.

To start the OnliNet agent:

On the Toolbar click , or from the Manage menu choose Agent Startup.

Stopping the Agent

You can stop the OnliNet agent from monitoring your system. You must enter your password to confirm the termination of the OnliNet agent. Once the OnliNet agent is terminated, the OnliNet status changes to idle mode.

NOTE Once you terminate the OnliNet agent, your system is no longer protected during prolonged outages.

NOTE For OnliNet Vista: If the selected host is in a user-created group, all OnliNet agents in that group are terminated. For example, if you select and terminate an OnliNet agent in any host from the group "MyHosts," which is user-created, all OnliNet agents in “MyHosts” are terminated.

To stop the OnliNet agent:

1. On the Toolbar click , or from the Manage menu choose Agent Termination.
2. Enter the password to confirm the termination. The default password is 1Power.
3. Click OK.

When the Agent is terminated, the main screen appears as shown in Figure 44.
To restart the OnliNet Agent:

On the Toolbar click , or from the Manage menu choose Agent Startup.

**Owner Registration**

1. On the Toolbar click , or from the Help menu choose Owner Registration.
2. Fill out the owner information in the fields.
3. Click Send to e-mail the form. Click Print to print the form so it can be faxed or mailed.

**NOTE** To send an e-mail from OnliNet, your e-mail package must be a 32-bit application that supports the MAPI protocol.

Registered owners are advised of all product updates. You can return the owner registration by e-mail, fax, or mail. If you print the form, the following information prints in addition to the owner information:

- Address for mailing the registration
- Numbers for faxing the registration
Problem Report

You can fill out and send a problem report online to the Help Desk. If e-mail is not available on your system, you can print and fax or mail the form.

To file a problem report:

1. On the Toolbar click \[\text{button} \], or from the Help menu choose Problem Report.
2. Fill out your name, phone number, and e-mail address.
3. Type in a description of the problem.
4. Click Send to e-mail the problem report to the Help Desk. Click Print to print the form so it can be faxed or mailed.
5. Click OK.

NOTE To send an e-mail from OnliNet, your e-mail package must be a 32-bit application that supports the MAPI protocol.

Print Setup

The Print Setup screen allows you to define a printer and print options for printing the Event Log, Owner Registration, and Problem Report. The content of this screen is operating system dependent. For PC applications, the operating system provides the screen. In UNIX systems, you must specify how you want to print the specified files. In addition to printing to a printer, you can also specify printing to a file.
CHAPTER 12

ONLINET VISTA

OnliNet Vista power management software gives system administrators monitoring and control capabilities over nodes in a network or enterprise. Running on Windows 95, Windows 98, and Windows NT 3.5x and 4.0 (Intel and Alpha processors), it monitors OnliNet Centro for Windows, NetWare, and UNIX as well as network adapters which OnliNet Centro does not monitor. Agents discovered run on any of the following:

- Windows networks using TCP/IP
- Novell NetWare networks using IPX
- Novell NetWare networks using TCP/IP
- UNIX-based networks using TCP/IP

If a Novell NetWare network is using both IPX and TCP/IP protocols, OnliNet Vista has an entry for both.

You can use the OnliNet Vista main screen to connect to remote UPS monitoring agents (see Figure 45). OnliNet Vista can monitor up to 128 nodes.

In the main screen’s Machine/Adapter list, colored icons identify the OnliNet system as follows:

- Indicates an OnliNet Centro UPS agent running on the computer.
- Indicates a network adapter such as a ConnectUPS.

An “L” icon indicates an OnliNet Lite UPS agent running on the computer.

To exercise monitoring or control functions on a system, select its icon and select the appropriate menu options.
Things to Know About OnliNet Vista

- Any UPS monitoring and management that can be done from OnliNet Centro can also be done from OnliNet Vista.
- When an alarm occurs, the associated icon changes colors to indicate a status change. To bring up an OnliNet Centro view, double-click the icon.
- A single display shows the status of all OnliNet Centro agents and network adapters.
- UPS nodes can be grouped on the OnliNet Vista screen for easier management.

Installing OnliNet Vista

Note the following points, and then see “Installing OnliNet” on page 15 for installation instructions.

- OnliNet Vista can be installed standalone on a machine that does not have OnliNet Centro installed, or it can be installed on top of an existing OnliNet Centro installation.
- OnliNet Vista does not have an operating system installation selection screen. Instead, the CD AutoPlay feature starts the installation.
- As with OnliNet Centro, the installation program searches for a previously installed version of OnliNet Vista and removes it before proceeding with the installation.
- The only option during the installation is location of the OnliNet Vista directory and associated files. The default directory is C:\Program Files\Onlinet.
Organizing Your OnliNet Vista Display

For easier management, organize UPS nodes into groups. For example, combine all UPSs in the accounting department into a group called Accounting. Then, by configuring only one UPS monitoring agent, that configuration is replicated to the entire group.

Creating a Group

1. On the Toolbar click , or from the Edit menu choose Add Group.
2. When prompted, type a name for the group.
   The Select Base Host dialog box opens with a list of available base hosts.
3. In the Select Base Host dialog box, select from the list of available nodes.

Whenever you change the configuration of the base host, the changes are replicated to the entire group.

Deleting a Group

1. On the Toolbar click , or from the Edit menu, choose Delete Group.
2. When prompted “Are you sure,” click Yes.

Adding a Host to a Group

Either select a host from the right-hand pane of Vista and drag and drop it onto a group name in the left-hand pane, or:

1. On the Toolbar click , or from the Edit menu, choose Add Host to Group.
2. In the Select Hosts dialog box, select a host or hosts.
   When you select a group, only the UPSs inside the group are displayed.

Deleting a Host from a Group

1. On the Toolbar click , or from the Edit menu, choose Delete Host from Group.
2. In the Select Hosts dialog box, select a host or hosts.
3. When prompted “Are you sure,” click Yes.

Adding Subnets to the Display

By default, Vista discovers OnliNet agents on the local subnet. To add other subnets:

1. On the Toolbar click , or from Edit menu choose Discover.
2. In the Discover dialog box, add another subnet.

Adding a New UPS to the Display

From the Edit menu, choose Rediscover.
Adding Network Adapters to the Display

1. On the Toolbar click \(\text{cu}\), or from the Edit menu choose Network Adapter.

2. In the Host Name field of the Edit Network Adapter dialog box, enter the host name or IP address for the ConnectUPS SNMP network adapter or other network adapters that support the standard SNMP MIB (Figure 46).

3. In the Get Community Name field, enter the community name that the SNMP manager uses when performing a get operation. The community name defaults to public if not specified.

4. In the Set Community Name field, enter the community name that the SNMP manager uses when performing set or get operations. The community name defaults to private if not specified.

5. Click Add.

![Edit Network Adapter Dialog Box](image)

Figure 46. Edit Network Adapter Dialog Box

Deleting Network Adapters from the Display

1. On the Toolbar click \(\text{cu}\), or from the Edit menu choose Network Adapter.

2. In the Known Adapters list of the Edit Network Adapter dialog box, select a host name (Figure 46).

3. Click Delete.

To shut down, restart, and perform diagnostic tests on a remote UPS, see the following section, “Managing Remote Agents.”
Managing Remote Agents

Using OnliNet Vista, you can manage a networked UPS even when it is not communicating with an OnliNet agent.

1. On the OnliNet Vista main screen, select a node.

2. On the Toolbar click [ ] or from the Manage menu choose Network Adapters. The Manage Adapter dialog box opens (see Figure 47).

3. In the Manage Adapter dialog box, reconfigure community names, shut down, restart, and perform a diagnostic test on a remote UPS.

What the Manage Adapter Dialog Box Controls

If a selected host is in a user-created group, the manage network adapter parameters apply to all hosts in that group. For example, if you click Pending Off Delay for any host in the “MyHosts” group, which is user-created, the Pending Off Delay applies to all hosts in “MyHosts.”
Reconfiguring a Community Name
In the Get or Set Community fields, type a new community name that the SNMP manager uses when performing a get or set operation. The get community name defaults to public and the set community name to private if not specified. This is an OnliNet Vista security feature.

Recording a Contact Name for System Questions
In the Contact Name field, type up to 63 alphanumeric characters.

Turning Off the UPS
Click UPS Off.
The seconds until the UPS is turned off are displayed in the Pending Off Delay field. To cancel the shutdown, click Abort Shutdown.
If the selected host is in a user-created group, all OnliNet agents in that group are terminated. For example, if you select and terminate an OnliNet agent in any host from the group “MyHosts,” which is user-created, all OnliNet agents in “MyHosts” are terminated.

Turning On the UPS
Click UPS On.
The seconds until the UPS is turned on are displayed in the Pending On Delay field.

Rebooting the Network Adapter
Click Restart SNMP Agent.
This should be used only if the network adapter is stalled or a reboot of the network adapter is required.

Canceling the Shutdown
Click Abort Shutdown

Running a Diagnostic Test
In the Diagnostic Test area, click Run Test
Results appear in the Test Results field.
If the selected host is in a user-created group, the diagnostic test is run on all hosts in that group. For example, if you select and run a diagnostic test on any host from the group “MyHosts,” which is user-created, the diagnostic test is run on all hosts in “MyHosts.”

Getting Information from OnliNet Vista

Viewing Waveforms and THD Data
From the View menu choose Oscilloscope.
If your UPS supports it, you can view the input and/or output waveforms and THD data for an agent.
Displaying Data in Graph Form

1. On the OnliNet Vista main screen, select a node.
2. From the Tools menu choose Data Collection.
3. In the OnliNet Data Collection dialog box, open a new file.
4. In the Meter Storage Configuration dialog box, select the meters to be sampled and stored (see Figure 48).
   The Create Meter Graph dialog box opens, displaying the list of sampled meters (see Figure 49).
5. In the Create Meter Graph dialog box, select the meters to graph.
6. In the Graph Name field, type a name for the new graph.
7. The graph opens inside the OnliNet Data Collection dialog box (see Figure 50).

![Figure 48. Meter Storage Configuration Dialog Box](image)
Figure 49. Create Meter Graph Dialog Box
Viewing the Central Event Log

The Central Event Log is a display of all alarms and events that occur on all OnliNet agents that OnliNet Vista discovers.

To access the Central Event Log, from the Tools menu choose Central Event Log. Sort entries by Host Name, Date & Time, or Event/Alarm.
CHAPTER 13
UNIX FUNCTIONS

This chapter covers the following OnliNet for UNIX functions:

- Tcentro Text-based Interface
- UNIX Command Line Options
- Monitoring a Remote UNIX Graphical Console

Tcentro Text-based Interface

The tcentro program is a text-based interface for OnliNet on UNIX systems when the operating system is not configured to support an X-Windows system. Tcentro gives those users without an X-Windows workstation the ability to configure shutdown parameters and scheduled shutdowns.

After tcentro starts, it attempts to establish communication with the daemon. If communication fails, tcentro informs the user and quits. If communication is successful, tcentro shows one of the following:

- The daemon (agent) is in normal status
- There is an alert or an emergency situation such as UPS on battery

Tcentro then asks you to configure shutdown parameters or a scheduled shutdown.

Tcentro Shutdown Parameters

Shutdown parameters include the following:

- The total time the UPS should power the system after UPS is on battery due to a power outage
- The time to wait before beginning the operating system shutdown process
- The time to wait before sending warnings to administrators
- The time to wait before sending warnings to the end users

You can specify that the UPS be automatically turned off after the operating system shutdown is complete. You can also configure a pre-shutdown command which is executed before the operating system shutdown process begins.

Tcentro Scheduled Shutdowns

For scheduled shutdowns, you can specify the shutdown time, the time to restart the UPS, and whether the operating system should be shut down before the UPS is automatically turned off. You can configure shutdowns on certain days (such as Sunday) in every week, one day in every month, or after a set number of days. You can periodically shut down the UPS as desired.
Command Line Options

Specifying a Serial Port
-d <port>   Specifies a serial port (for example, /dev/ttya)

Connecting a Client to a New Host
-h <host name>   Connects a client to the host name specified (use a domain name or IP address). For example, -h redsox.

NOTE The specified host must have an OnliNet 4.x agent (daemon) running.

Killing the Agent
/opt/onlinet/V4/agent/onkill
onkill can be used to kill the agent.
“onkill -n” will kill the agent gracefully.
“onkill -f” will forcefully kill the agent if “onkill -n” fails.

Starting the OnliNet Daemon Manually
/opt/onlinet/V4/agent/start_daemon
start_daemon can be used to start the OnliNet daemon service manually.

Monitoring a Remote UNIX Graphical Console

The X-Windows system has its own type of access control. The OnliNet 4.x agent (daemon) includes a small Motif program that duplicates any console messages to a system-modal dialog box that pops up on the screen if X-Windows is running. To receive these messages, disable access control for the display, using the following command:

$xhost + <machine name>

For security reasons, become familiar with UNIX security, specifically with the disadvantages of using the xhost command to allow access. In some instances, the benefits of receiving graphical console messages may not be worth the potential security hazards.
CHAPTER 14
TROUBLESHOOTING

This chapter addresses questions and problems that have been reported and their solutions.

No UPS Attached Message

When you start the software, OnliNet tests for a loop-back in the cable to verify that the cable is attached. Be sure you are using the cable that came with OnliNet Centro. For the Prestige and 9125 UPSs, the part number is 124102017-001. For the 5105, 5119, and 9150 UPSs, the part number is 124102018-001. The 9125 UPS has a 25-pin to 9-pin adapter.

If you are sure you have the correct serial cable, verify that the com port used is the same as configured in the software.

User Doesn’t Have an OnliNet Centro Cable

OnliNet Centro for Windows allows you to disable the loop-back function. The procedure is as follows:

1. On the Configure menu, point to Communications and click Serial Device.
2. In the Configure Serial Device dialog box, select Disable Serial Loopback test.

If the No UPS Attached message continues, repeat the procedure. It may take OnliNet a few moments to poll the network and complete the discovery process.

NetWare Does Not See Systems Running OnliNet in UNIX

If you cannot see your UNIX servers from your NetWare server, install TCP/IP on the NetWare server. If TCP/IP is not installed, OnliNet automatically uses the IPX protocol, and UNIX systems do not respond to IPX queries.

OnliNet is Sending Me an Error Message

For a list of error messages and their explanation, see “Alarms and Alerts” on page 105.

BadDrawable Error on Solaris 2.5.1

Q. I tried to start the OnliNet Centro user interface on my Solaris 2.5.1 system and received the following error message “error of failed request: BadDrawable (invalid pixmap or window parameter).” How do I correct this?

This indicates that too many screen resources have been used up. There are not enough resources left for drawing the OnliNet Centro images. The solution is to close other open windows that are using resources. In addition, OnliNet Centro and Netscape will not run at the same time on some systems. If you have Netscape running, close it before starting OnliNet.
Troubleshooting

Can’t Open File Error on Solaris 2.5.1

Q. I tried to start the OnliNet Centro user interface on my Solaris 2.5.1 system and received the following error message “ld.so.1: /usr/onlinet/V4/gui/centro: fatal: libXm.so.1.2: can’t open file: errno=2.” How do I correct this?

This indicates that the Motif libraries are not where OnliNet Centro expects them. The solution is to first, make sure that you have the CDE installed (this fix was tested using CDE 1.1). The required libXm.so files come from the CDE. If the CDE is not installed, then the fix will not work. Furthermore, a full installation of 2.5.1 is required, not just the end-user installation. One way to find out if the correct libXm.so libraries are already installed on the system is to use the commands:

```
find / -name “libXm.so**“ -print
find / -name “libXt.so*” -print
find / -name “libX11.so*” -print
```

After verifying that the libXm.so libraries are installed, log in as root and copy the two script files onlinet_fixup and run_centro to the /tmp directory. Both files must have the correct permissions. To correctly set the permissions use the following two commands:

```
chmod 777 onlinet_fixup
chmod 500 run_centro
```

Finally, run the onlinet_fixup script. This will set up links to the libxm.so libraries and copy the new version of run_centro to the /usr/onlinet/V4/gui directory.

```
#!/bin/sh
# Script to solve library problem on Solaris 2.5.1 for OnliNet 4.0
# 7/22/98 --BDB
/bin/ln -s /usr/dt/lib/libXm.so.3 /usr/dt/lib/libXm.so.1.2
/bin/ln -s /usr/openwin/lib/libXt.so.4 /usr/openwin/lib/libXt.so.5.0
/bin/ln -s /usr/openwin/lib/libX11.so.4 /usr/openwin/lib/libX11.so.5.0
cp run_centro /usr/onlinet/V4/gui
echo “Done!”
```

```
#!/bin/sh
HHHOME=/usr/onlinet/V4/gui/hyperhelp ; export HHHOME
OLNHELPDIR=/usr/onlinet/V4/gui/OLNHelp ; export OLNHELPDIR
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/onlinet/V4/gui/xpm/lib:/usr/dt/lib:/usr/openwin/lib
export LD_LIBRARY_PATH
/usr/onlinet/V4/gui/centro $*
```

Removing FailSafe III Plug and Play Driver

Q. How do I remove the FailSafe III Plug and Play Driver from Windows 95 if I want to replace it with OnliNet?

Use the Windows Device Manager to select the UPS from the list under Other and select Remove. Then use Add/Remove Programs from the Control Panel (select FailSafe III Plug and Play Driver) to remove executables and related files. Use the following procedure to verify removal of the Plug and Play driver. Be sure to execute any steps that left behind files or registry entries.
Verify removal of the Plug and Play Driver in five steps as follows:

1. Remove the following files from the Windows System directory (folder):
   - FS3PNP.VXD
   - FS3PNP.EXE
   - FS3PNP.CPL
   - FS3REMOV.EXE
   - IPCDLL.DLL
   - UPS0001.DLL
   - UPSFFFF.DLL

   **NOTE** The FailSafe III PNP driver also installs two shared files, MFC40.DLL and MSVCRT.DLL. We recommend retaining these files.

2. Remove the Deltec INF file.
   
   For the original release of Windows 95 this file will be in the \Windows\Inf directory (folder) and probably is named 'OEM0000.INF'. If you have multiple OEMxxxx.INF files, view them in Notepad (double-click on the .INF file) and delete those that refer to the FailSafe III Windows 95 Plug and Play Device Driver and Control Panel Applet.
   
   For the OSR2, OSR3, Memphis, and Windows 98 releases, this file is located in the \Windows\Inf\Other directory (folder) and is named ‘Deltec~1.inf.

   **NOTE** Steps 3–5 require you to manually remove Key entries via the Windows Registry editor (REGEDIT.EXE). Be sure to back up your registry file prior to these steps.

3. From REGEDIT, remove the key
   - MyComputer\HKEY_LOCAL_MACHINE\Enum\SERENUM\DEL0001
   (This key may also be named EXI0001 or FPS0001 depending on the UPS model).

4. From REGEDIT, remove the key
   - My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\FailSafe III

5. From REGEDIT, remove the key
   - MyComputer\HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\FailSafe III

**OnliNet Won’t Reboot**

**Q. OnliNet turns off my system, but why won’t it restart?**

OnliNet provides the signals to shut off and restart any attached loads. Successful shutoff and restart is hardware-dependent and all UPSs do not have the ability to respond. Some UPS models have advanced features and can shut down and restart individual attached loads.

Some new computers assembled with ATX motherboards have an energy saving feature that prohibits the CPU from powering on again without user intervention, disabling the OnliNet reboot feature. Research is in progress to provide a workaround and to enable the software to return power to the CPU and reboot the computer.
## Chapter 15

### Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Agent</strong></td>
<td>A process that waits in the background ready to perform some action for OnliNet. The agent has to be running in order for OnliNet to monitor the UPS and shut down your equipment. In the UNIX environment, the agent is called a daemon.</td>
</tr>
<tr>
<td><strong>Battery Mode</strong></td>
<td>A system state indicating that the UPS battery is powering the equipment load. When utility power returns, the UPS switches to Normal mode. The battery recharges at this time. OnliNet automatically displays warning messages when the system switches to Battery mode, and when a low battery situation occurs. To program OnliNet to send further messages, see “Configuring Event Notification” on page 57. If your UPS supports it, open the Configure menu and from Options select Configure UPS Options to configure whether the low battery warning is sent with either two or five minutes of run time remaining. If your system goes to Battery mode, save your work to prevent data loss.</td>
</tr>
<tr>
<td><strong>Bypass Mode</strong></td>
<td>A UPS state in which utility power runs the protected equipment. The UPS passively filters the power. When the UPS is in Bypass mode, battery protection is not available.</td>
</tr>
<tr>
<td><strong>Client Serial Device</strong></td>
<td>See Serial Device.</td>
</tr>
<tr>
<td><strong>Contact-Closure Cable</strong></td>
<td>A contact-closure cable has pins 2 and 3 wired together at one end of the cable. The wires do not go from one end of the cable to the other. Refer to the UPS user’s guide for additional information on contact closures.</td>
</tr>
<tr>
<td><strong>Daemon</strong></td>
<td>See Agent.</td>
</tr>
<tr>
<td><strong>Error Log</strong></td>
<td>A text-file record of all software errors. It is stored in the OnliNet directory. Entries consists of a time stamp, error location, and the return value of the failed system call, if available. This file is e-mailed to the Help Desk during automated problem reporting.</td>
</tr>
<tr>
<td><strong>Idle Mode</strong></td>
<td>The communication port is not configured. While in Idle mode, OnliNet does not communicate with the UPS.</td>
</tr>
<tr>
<td><strong>Load</strong></td>
<td>The load is the equipment that is protected by the UPS.</td>
</tr>
<tr>
<td><strong>Load Segment</strong></td>
<td>A UPS facility for dividing your load into two or more groups with different shutdown and restart times configured in the software. One load segment is considered critical while the other is considered non-critical. Shutdown and restart times are assigned accordingly. To determine whether your UPS supports load segments, see your UPS user’s guide.</td>
</tr>
<tr>
<td><strong>Local Serial Device</strong></td>
<td>See Serial Device.</td>
</tr>
<tr>
<td><strong>Network Adapter</strong></td>
<td>A network adapter is a printed circuit board that plugs into a workstation or server and allows OnliNet to communicate with a UPS over a network.</td>
</tr>
<tr>
<td><strong>Network Client</strong></td>
<td>A network client is a host computer that is connected to a UPS through a network connection (client serial device). The host computer is powered by the UPS, but receives UPS communication through another device (server serial device).</td>
</tr>
<tr>
<td><strong>Normal Mode</strong></td>
<td>When operating in Normal mode, the UPS filters and regulates incoming AC power, eliminating noise and voltage spikes, and provides consistent power to your equipment.</td>
</tr>
<tr>
<td><strong>OnliNet</strong></td>
<td>OnliNet Power Management Software products complement the UPS to provide you with protection against data loss and prolonged down time. OnliNet works with your UPS to keep data intact during a power failure. During the battery-powered grace period provided by the UPS, OnliNet enacts a clean and efficient shutdown of your computer system.</td>
</tr>
<tr>
<td><strong>Serial Device</strong></td>
<td>The means by which the UPS sends signals to the connected computer. Serial devices may be local, server, or client. OnliNet communication must be configured to reflect the actual communication hardware setup, including serial port in use.</td>
</tr>
</tbody>
</table>
### Glossary

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial Loopback Test</td>
<td>A polling of the system to be sure the correct communication cable is in use. This test can be disabled at the Configure Serial Device dialog box (see page 36).</td>
</tr>
<tr>
<td>Server Serial Device</td>
<td>See Serial Device.</td>
</tr>
<tr>
<td>UPS Group</td>
<td>A system consisting of one UPS supporting two or more computers where: One computer (known as the Centro server or UPS group controller) communicates with the UPS either serially or through a network adapter; the other computers (known as the Centro clients or UPS group members) are powered by the same UPS; and the UPS group members are configured to be in an idle mode awaiting commands from the UPS group controller.</td>
</tr>
</tbody>
</table>
## CHAPTER 16
### ALARMS AND ALERTS

Under routine operating conditions, the OnliNet main screen displays a Normal Operation message. The screen background color is green. In the event of a power or equipment failure, the screen background color changes to red and a system message appears to describe the situation. The following table lists these messages and their meanings.

<table>
<thead>
<tr>
<th>System Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapter not found</td>
<td>OnliNet was trying to communicate with the UPS through a network adapter, but no adapter was found. Verify the host name or IP address and make sure the adapter is on the network.</td>
</tr>
<tr>
<td>Bad Battery Detected</td>
<td>OnliNet has detected a problem with the UPS battery. Refer to your UPS user’s guide for battery information. This error may indicate that the battery needs replacing.</td>
</tr>
<tr>
<td>Bad Battery Alarm Cleared</td>
<td>The bad battery alarm has been cleared and the UPS is operating normally.</td>
</tr>
<tr>
<td>Bypass</td>
<td>The load is being powered by utility power. However, utility power continues to be passively filtered by the UPS. Battery protection is not available while in Bypass Mode. Refer to the UPS front panel for alarm indications. If the UPS does not return to normal operation soon, refer to your UPS user’s guide for troubleshooting information.</td>
</tr>
<tr>
<td>Cable is not attached to &lt;selected port&gt;</td>
<td>OnliNet was unable to detect the cable attached to the UPS. Verify that the correct port is specified and that an OnliNet 4.0 cable is being used. <strong>NOTE:</strong> OnliNet 4.0 does not work with a standard RS-232 cable or cables shipped with OnliNet 3.x.</td>
</tr>
<tr>
<td>Clear Utility Under Voltage - Boost</td>
<td>The input voltage is within acceptable limits and the UPS is operating normally.</td>
</tr>
<tr>
<td>Communications with UPS Lost</td>
<td>OnliNet has lost communication with the UPS. Verify the serial cable connection and re-establish communication by selecting Serial Device from the Communications submenu under Configure. OnliNet will automatically re-establish communication with the UPS.</td>
</tr>
<tr>
<td>Diagnostic Test in Progress</td>
<td>A diagnostic test of the UPS is in progress. Once the test is complete, OnliNet will log the results in the user-specified file. You can view the file by selecting Diagnostic Results from the View menu.</td>
</tr>
<tr>
<td>Diagnostic Test Completed</td>
<td>The diagnostic test of the UPS has completed. Select Diagnostic Results from the View menu to view the results of the diagnostic test.</td>
</tr>
<tr>
<td>Input Out of Tolerance</td>
<td>The input power is out of tolerance in voltage, frequency, or phase rotation. The utility power is out of specification for your UPS. The UPS will continue to operate until the utility power is no longer acceptable.</td>
</tr>
<tr>
<td>Input Parameters Returned to Normal</td>
<td>The utility line voltage, frequency, or phase rotation has returned to normal and the UPS is operating normally.</td>
</tr>
<tr>
<td>Low Battery</td>
<td>The UPS battery capacity is low. Allow the UPS battery to recharge for 24 hours. OnliNet sends a low battery warning indicating approximately two or five minutes (specified in Configure UPS Options) before UPS shutdown. This warning is approximate, and the actual time to shutdown may vary significantly. Once this warning is indicated, the system will immediately shut down.</td>
</tr>
<tr>
<td>Low Battery Alarm Cleared</td>
<td>The low battery alarm has been cleared and the UPS is operating normally.</td>
</tr>
<tr>
<td>No UPS attached</td>
<td>OnliNet is trying to communicate with the UPS through a network adapter, but the adapter is not communicating with the UPS. Verify that the adapter is attached to the UPS. If the adapter is attached to the UPS, refer to the adapter's user's guide for more information.</td>
</tr>
<tr>
<td>System Message</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>No UPS Configured</td>
<td>OnlIriNet is waiting to be configured. To configure a UPS, select Serial Device or Network Adapter from the Communications submenu under Configure.</td>
</tr>
<tr>
<td>Normal Operation</td>
<td>The UPS is operating as it should and OnlIriNet is monitoring your system.</td>
</tr>
<tr>
<td>Overload</td>
<td>Too much equipment has overloaded the power rating of the UPS. Reduce the equipment connected to the UPS. Refer to your user’s guide for overload information. You may need to reset the UPS.</td>
</tr>
<tr>
<td>Overload Alarm Cleared</td>
<td>The overload condition has been cleared and the UPS is operating normally.</td>
</tr>
<tr>
<td>Program Started</td>
<td>The OnlIriNet agent has been started.</td>
</tr>
<tr>
<td>Program Terminated</td>
<td>The OnlIriNet agent has been stopped. Your system is no longer protected against prolonged outages.</td>
</tr>
<tr>
<td>Remote Configuration Change</td>
<td>Your configuration has been changed remotely by your network administrator.</td>
</tr>
<tr>
<td>Remote Shutdown</td>
<td>A remote system has configured your system to be shut down. Immediately complete and save your work to prevent data loss and similar difficulties.</td>
</tr>
<tr>
<td>Scheduled Shutdown In Progress</td>
<td>A scheduled shutdown is about to begin. Immediately complete and save your work to prevent data loss and similar difficulties.</td>
</tr>
<tr>
<td>Scheduled Shutdown Pending</td>
<td>A scheduled shutdown has been configured for your system. Refer to “Scheduling Shutdowns” on page 79 for shutdown details.</td>
</tr>
<tr>
<td>Shutdown Due to Power Failure</td>
<td>A shutdown is about to occur because of a power failure. Immediately complete and save your work to prevent data loss and similar difficulties.</td>
</tr>
<tr>
<td>Software Error</td>
<td>An error has occurred in the OnlIriNet software. If this error persists, submit a problem report or call the Help Desk.</td>
</tr>
<tr>
<td>Software Error Cleared</td>
<td>The software error has been cleared and OnlIriNet is operating normally.</td>
</tr>
<tr>
<td>UPS Discovery in Progress</td>
<td>OnlIriNet is attempting to locate and configure the UPS.</td>
</tr>
<tr>
<td>Unable to open port &lt;selected port&gt;</td>
<td>OnlIriNet is trying to communicate with the UPS and the UPS port is being used by another device or the port has not been configured. Select another port, stop the application using the port, or configure the port by selecting Serial Device from the Communications submenu under Configure.</td>
</tr>
<tr>
<td>UPS is not attached to &lt;selected port&gt;</td>
<td>The OnlIriNet 4.0 cable was detected, but OnlIriNet received no response from the UPS. Make sure the UPS is turned on and that the cable is securely attached to the UPS.</td>
</tr>
<tr>
<td>UPS Component Failure Alarm Cleared</td>
<td>The component failure alarm for the UPS has been cleared and the UPS is operating normally.</td>
</tr>
<tr>
<td>UPS Returned from Bypass</td>
<td>The UPS has returned from Bypass Mode and is powering your equipment.</td>
</tr>
<tr>
<td>UPS Re-established Communication</td>
<td>The UPS has re-established communication with the OnlIriNet application.</td>
</tr>
<tr>
<td>UPS on Battery</td>
<td>The UPS system is now operating on battery power. Unless you specify in the shutdown parameters to turn off both your system and the UPS, the UPS will continue to run on battery until the battery is completely discharged or until power is returned.</td>
</tr>
<tr>
<td>UPS Component Failed</td>
<td>Some internal component of the UPS (rectifier, inverter, or control panel) has failed. Call your UPS service representative or refer to your UPS user’s guide for service information.</td>
</tr>
<tr>
<td>Utility Over Voltage - Buck</td>
<td>The input voltage is too high for the UPS. The UPSbucks the voltage down to acceptable limits. Refer to your user’s guide for more information on buck and boost.</td>
</tr>
<tr>
<td>Clear Utility Over Voltage - Buck</td>
<td>The input voltage is within acceptable limits and the UPS is operating normally.</td>
</tr>
<tr>
<td>Utility Under Voltage - Boost</td>
<td>The input voltage is too low for the UPS. The UPS boosts the voltage up to acceptable limits. Refer to your user’s guide for more information on buck and boost.</td>
</tr>
<tr>
<td>Utility Power Restored</td>
<td>Input power has been restored to the UPS. The UPS is no longer operating on battery.</td>
</tr>
</tbody>
</table>
CHAPTER 17
DIGITAL SERVERWORKS MANAGER PLUG-IN

An OnliNet plug-in allows administrators of Digital ServerWORKS Manager to access the information from OnliNet agents running on the network without having to run OnliNet Vista. You can access the OnliNet Centro user interface from within Digital ServerWORKS Manager.

Once the plug-in is installed, the next time Digital ServerWORKS Manager is started the OnliNet agents are automatically discovered. If the UPS status changes to On Battery, the color-coded icon representing the managed entity changes from green to red.

If Digital ServerWORKS Manager is running when the plug-in is installed, you must perform an IP discovery to view the OnliNet agents. The agents found during this discovery are stored in a static list. The IP discovery process must be performed each time agents are added or removed.

To verify that the OnliNet plug-in is installed, on the Digital ServerWORKS Manager Tools menu click Application Launch. In the Configure Application Launch dialog box, look for OnliNet Centro Plug-in, as shown in Figure 51.

![Figure 51. Configure Application Launch Dialog Box](image-url)
In Digital ServerWORKS Manager all the machines discovered on the network are displayed, as shown in Figure 52.

Figure 52. Digital ServerWORKS Manager Display
When a node is selected that had an OnliNet agent running during the IP discovery process, a Centro icon appears on the button bar, as shown in Figure 53.

![Figure 53. Digital Server Works Manager Screen](image)

To start OnliNet Centro, click an icon on the Digital ServerWORKS Manager screen.
CHAPTER 18
CINTRIX WINFRAME 1.6

Winframe is a 'thin-client' version of Windows NT that allows Windows NT servers to act as application servers. This software uses the ICA protocol and is licensed by Microsoft for inclusion in Windows NT 5.0. When OnliNet Centro is started on the Winframe server, only the opening splash screen is displayed. The user interface, centro.exe, is not getting registered with the Winframe operating system.

The solution is to install OnliNet normally, but do not reboot the computer at the end of the installation. Perform the following steps:

1. On the taskbar, click Start, point to Settings, and then click the Control Panel
2. On the Control Panel, double-click Services and stop the Agentnt service.
3. In a command prompt window, change directories to where centro.exe exists.
   (default is c:\Program Files\Centro)
4. At the command prompt, issue the command: register centro.exe /system
5. Reboot the computer or restart the Agentnt service.

The Centro user interface is now registered with the Winframe operating and operates properly.